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GTB, a collection of geometric analysis tools following three principles: 

1. Spatial information: Where are hotspots/changes? Provide spatially explicit 
information, which is crucial for monitoring progress and spatial planning. 
Statistical summaries can always be derived from a map, but they do not 
capture the spatial variability of the spatial map product. 

2. Quantitative indicators: How much? Provide intuitive, ideally normalized, 
indicators for effective reporting. Quantify the status and measure trends. 

3. Generic and flexible: How? Make exclusive use of geometric concepts 
resulting in a generic reference framework that can be equally applied to any 
kind of raster data and at any scale; parameterize the analysis setup allowing 
to fine-tune the analysis to end-user requirements. 

 
GTB is free and open-source software. This document describes the various menus 
and features of GTB:  
 

 
  

https://forest.jrc.ec.europa.eu/en/activities/lpa/gtb/
mailto:peter.vogt@ec.europa.eu?subject=GuidosToolbox%20question
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GTB requires a PC or a Mac with Intel/Apple Silicon M CPU and at least 4 GB of system 
memory, the more the better. This 64-bit application has been tested on a variety of 
Linux distributions, macOS, and Microsoft Windows 10/11 platforms. The latest GTB 
version can be downloaded from the GTB homepage.  

Support will be provided for the most recent GTB version only, downloaded from the 
official homepage and following the  GTB installation instructions. 

 

 

GWB, the GuidosToolbox Workbench, contains the most popular GTB image analysis 
modules as a command-line application for Linux 64bit servers, desktop, or 
workstations. GWB is available for a variety of Linux distributions and can be installed 
system-wide or used as a standalone application on systems, where users do not have 
root privileges. GWB is also available on the FAO SEPAL and the JRC BDAP JEO-desk 
cloud computing platform. 
 
License information: using the compiled version of GTB or GWB requires accepting 
the respective End User License Agreement for GTB or GWB. The open-source code of 
GTB and GWB and all dependencies is released under GPL version 3 on GitHub for GTB 
and GWB. 
 
 
 
Citation reference: 
 
Vogt P., Riitters, K., 2017. GuidosToolbox: universal digital image object analysis. 
European Journal of Remote Sensing 50:1, 352-361,  
DOI: 10.1080/22797254.2017.1330650. Software available for free at: 
https://forest.jrc.ec.europa.eu/en/activities/lpa/gtb/ 
 
Vogt P., Riitters, K., Rambaud P., d’Annunzio R., Lindquist E., Pekkarinen A. 2022. 
GuidosToolbox Workbench: spatial analysis of raster maps for ecological 
applications. Ecography, Volume 2022, Issue 3, Software note, 1-7,  
DOI: 10.1111/ecog.05864.  Software available for free at: 
https://forest.jrc.ec.europa.eu/en/activities/lpa/gwb/ 
 
 
Please add the following reference if you use MSPA in your work: 
Soille P., Vogt P., 2008. Morphological segmentation of binary patterns. Pattern 
Recognition Letters 30, 4:456-459. DOI: 10.1016/j.patrec.2008.10.015 
 
MSPA open-source reference paper:  
Soille P. and Vogt P. (2022). Morphological spatial pattern analysis: open source 
release. The International Archives of the Photogrammetry, Remote Sensing and 
Spatial Information Sciences, Volume XLVIII-4/W1-2022 Free and Open Source 
Software for Geospatial (FOSS4G) 2022 – Academic Track, 22–28 August 2022, 
Florence, Italy. pp. 427-433, DOI: doi.org/10.5194/isprs-archives-XLVIII-4-W1-2022-
427-2022 

https://forest.jrc.ec.europa.eu/en/activities/lpa/gtb/
https://ies-ows.jrc.ec.europa.eu/gtb/GTB/GuidosToolbox_Installation.pdf
https://forest.jrc.ec.europa.eu/en/activities/lpa/gwb/
https://docs.sepal.io/en/latest/modules/dwn/gwb.html
https://jeodpp.jrc.ec.europa.eu/bdap/
https://ies-ows.jrc.ec.europa.eu/gtb/GTB/EULA_GTB.pdf
https://ies-ows.jrc.ec.europa.eu/gtb/GWB/EULA_GWB.pdf
https://github.com/ec-jrc/GTB
https://github.com/ec-jrc/GWB
https://doi.org/10.1080/22797254.2017.1330650
https://forest.jrc.ec.europa.eu/en/activities/lpa/gtb/
https://doi.org/10.1111/ecog.05864
https://doi.org/10.1111/ecog.05864
https://forest.jrc.ec.europa.eu/en/activities/lpa/gwb/
https://doi.org/10.1016/j.patrec.2008.10.015
https://doi.org/10.5194/isprs-archives-XLVIII-4-W1-2022-427-2022
https://doi.org/10.5194/isprs-archives-XLVIII-4-W1-2022-427-2022
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Windows and menus 

 
The following graphical elements can be used to interact with GTB: 
 
➢ a horizontal menu bar (top panel) 
➢ a window to set different attributes of the image and its graphical display (top left 

panel) 
➢ a window to set MSPA parameters and statistics (bottom left panel) 
➢ a viewport (right panel) 
➢ a window for image coordinates & values (bottom right panel) 
 
 
 
 
 

1. The menu bar of GTB 
 
The top menu bar offers four pull-down menus: 
 

➢ File 
➢ General Tools 
➢ Image Analysis 
➢ Help 
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1.1. The File pull-down menu  

 
The File pull-down menu offers the following options: 
 

➢ Read Image 
➢ Save Image 
➢ Batch Process 
➢ Change 
➢ Set Data Directory 
➢ Tif-Compression 
➢ Exit 
 
 

1.1.1 Read Image 

 
This menu is used to read your input data: 
 
➢ GeoTIFF: the default image type is GeoTIFF (a .tif-formatted file having a 

geoheader - information on projection, etc.). GeoTIFF can be read or pre/post-
processed by any image processing (IP) software. 
 

➢ Generic: images of formats like tif, png, bmp, jpeg, etc. 
 

➢ IP Software: image processing (IP) software (ESRI, ARC, IDRISI, etc.) raster image 
formats like img, bil, etc. The included GDAL library will try to convert these formats 
into GeoTIFF. Alternatively, go back into your IP software and export the image to 
GeoTIFF.  
 

➢ ENVI: an image from an ENVI session (file extension: .hdr). GTB will not use the geo-
information of the ENVI-data.  If you want to maintain the geo-information you 
should export the data in ENVI to GeoTIFF and then read this format in GTB.  

 
 

1.1.2 Save Image 

 
This menu is used to save your processed data. The options are similar as in the Read 
menu. Additional options are: 
 
➢ Display Snapshot: this option will save a snapshot of the current viewport in GTB. 

This may be useful when working with a large image and a quick look of the 
processed image is sufficient. When saving a MSPA result, the filenames will 
include the settings of the 4 MSPA parameters. If MSPA statistics were enabled, 
an additional file containing these statistics will be saved with the same notation 
and the file extension .txt. 
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➢ GoogleEarth KML: this option will export to kml-format for visualization in Google 
Earth, requiring an image in the projection EPSG:4326 (WGS 84). To re-project 
either use REPROJECT FOR GOOGLEEARTH or start the GTB TERMINAL and 
use the command gdalwarp and the appropriate EPSG reference codes. The result 
is stored in a zip-archive. Extract this zip-archive at any location and load the 
included kml-file into Google Earth. When exporting a MSPA or a FAD image, a 
customized header plus legend is added automatically.  

 
The default data directory is the subdirectory data located in the main GTB directory. 
Please use the default GeoTIFF format for maximum compatibility.  
 
 

1.1.3 Batch Process 

 
This option allows for automatic processing of multiple files in batch mode. Please put 
all batch input files into a dedicated empty subdirectory within the directory 
GuidosToolbox/data and avoid empty spaces in file names or directory path names. Input 
files must be in the default format (Geo-)Tiff. GTB will save the output files in batch-
processing specific directories located next to the batch-input directory, i.e., batch-
input files directory: GuidosToolbox/data/batch-input/ and resulting output files (for 
example for Accounting) are in the directory: GuidosToolbox/data/batch-ACC/. Batch-
processing options are like the respective options in the Image Analysis menu. 
 

Objects: 
 
➢ Accounting: batch processing of ACCOUNTING. 

 
➢ Parcellation: batch processing of PARCELLATION. 
 
 
Pattern: 
 
➢ Morphological: this option will process the user-selected files using the following 

options:  
• SPA2/3/5/6: this option calculates the Simplified Pattern Analysis, a down-

scaled version of MSPA, resulting in 2/3/5/6 classes and saves the resulting 
maps and statistics in the input directory. Images processed with SPAx are 
not subject to the MSPA MAXIMUM SIZE.  

• MSPA: this option will open a window to select the MSPA parameters and 
a switch for statistical output. The resulting filenames will include the 
settings of the 4 MSPA parameters and, if selected, separate statistics. 

 
➢ Moving Window: this menu provides options for batch processing of several 

moving window algorithms. The dimension of the moving window can be 
specified via a popup window (FIGURE 6). 

https://gdal.org/programs/gdalwarp.html
https://spatialreference.org/ref/epsg/
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➢ GraySpatCon: Batch process images for GRAYSPATCON. 

 
 
Network: 
 
➢ MSPA-based: this menu provides options for batch processing of several network 

analysis algorithms featured in the Image Analysis – GRAPH Theory Network 
(GTN) section. All options require MSPA input images, non-MSPA input images are 
ignored and cannot be processed. 
 

➢ ConeforInputs: this option will generate the node file (area per object) and the 
connection file (pairwise distance between objects) in the format required by 
Conefor.  Object area and distance will be calculated for objects of value 2 only (if 
needed, use Recode to reassign object values). The distances can be calculated as 
Euclidean edge-to-edge distance (8/4-connected) or centroid-to-centroid distance 
between all foreground objects of the raster image.  

Figure 1: ConeforInputs: Select 8/4-connectivity and distance measure. 

 
 

When using the option ConeforInputs the connectivity is defined via the pairwise 
distance between image objects. This is different to the option MSPA 

CONEFORINPUTS, where the connectivity is defined via the MSPA-detected 
structural connectors (Bridges). 

 
 
Fragmentation: 
 
This menu provides options for batch processing of several fragmentation analysis 
algorithms featured in the Image Analysis – FRAGMENTATION section. 
 

 
Distance: 
 
➢ Euclidean Distance: batch process images for Euclidean Distance resulting in maps 

and a summary of the distance histogram properties. 
 
 
 

Restoration Status:  
 
Batch process images for RESTORATION STATUS. 

http://www.conefor.org/
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Recode Classes:  
 
Batch recoding for a series of images. Batch-recoding requires a recoding table with 
256 entries to deal with all kinds of class allocations. A recoding table can be set up 
from scratch or saved and restored later. Here, please use the naming scheme 
GTBbatchrecode_*.sav, and replace the placeholder * with a meaningful name. After the 
recoding table has been defined, select a series of images to which this recoding table 
should be applied. 
 
 

1.1.4 Change 

 
This menu provides the following options for change analysis. A popup window allows 
for selecting the two input images, which are then processed: 
 
➢ FOS: this option will calculate changes in fragmentation classes between two FOS 

images. The summary statistics for the fixed, user-selected observation scale are 
saved in txt and csv-format. 
 

➢ FAD Multiscale: this option will compare two FAD MULTISCALE image sets and 
calculate changes in fragmentation classes over all observation scales as well as 
the multi-scale image. All changes are summarized in a bar-plot image and further 
detailed in observation-scale specific summary statistics provided in txt and csv-
format. The output files are: 
a) fadchange_barplot.png: FAD-bar chart summary 
b) fadchange_{7,13,27,81,243,mscale}.txt: FAD summary statistics. 
c) fadchange_{7,13,27,81,243,mscale}.csv: FAD change summary statistics by scale in 

comma-separated value format for import into a spreadsheet application 
The first table shows the number of pixels in each FAD-class or in the background 
at time A and B. If the area of a pixel is known and constant throughout the image 
(equal-area projection) then the number of pixels times the pixel-area corresponds 
to actual area measures. Gross area gain equals to the number of pixels changing 
from background at time A to any foreground class at time B. Similarly, gross area 
loss equals the number of pixels changing from any foreground class at time A to 
background at time B. The net area change is the sum of gross area gain and gross 
area loss. 
The second table shows relative changes within the foreground only. Entries along 
the diagonal of the matrix are zero because these entries correspond to pixels 
being in the same class at time A and B. Matrix entries below the diagonal 
represent fragmentation increase (+), and Fragmentation decrease (-) is found 
above the matrix diagonal.  

 
➢ Landscape Mosaic heatmap: this option will calculate the difference of the 

occurrence frequency [%] in the heatmaps of image B minus image A. The resulting 
delta heatmap image and the corresponding csv-table are saved into the GTB/data 

directory.  
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➢ Simple Change: this option will calculate a by-pixel difference of image B minus 

image A with the same input and output notation as described for the following 
Morphological Change.  

 
➢ Morphological Change: this option will conduct a Morphological Change 

Detection (MCD), described in Seebach et al. (2013). MCD will remove unwanted 
spurious changes caused by misregistration between classified maps and their 
thematic accuracies. MCD requires that both input images are binary and MSPA-
compliant maps (2b – FG, 1b – BG, 0b – Missing (optional)) in GeoTIFF format, 
having the same projection, pixel-resolution, location, and area in common. The 
resulting GeoTIFF image will show the essential changes in the common area of 
input image A and B. The output values have the following assignment: 11b – 
BG/BG, 12b – BG/FG (gain), 21b – FG/BG (loss), 22b – FG/FG, 176b – neglected, 
spurious changes, 255b – undetermined (missing data in either input image). The 
title bar lists net percent change values for FG (Foreground) and FGi (Foreground 
interior area: 1-pixel eroded FG), with negative values indicating a net loss. Finally, 
Elasticity (Riitters et al., 2015) is the ratio of FGi to FG. For example, in case of 
forest loss higher elasticity values indicate higher fragmenting effects on the 
remaining forests. 

 
 

1.1.5 Set Data Directory 

 
Use this option to define the default data directory, preset as GuidosToolbox/data. GTB 
will read input images from and write output into this directory. The default data 
directory location is reused after restarting GTB. 
 
 

1.1.6 Tif-Compression 

 
While GTB-output is always compressed, Tif-files generated by other GIS applications 
(i.e., ArcGIS) are often uncompressed and hence occupy a significant amount of disk 
space. Use this option to select one, or more Tif-files to be tested for file compression. 
If a selected Tif-file is found to be uncompressed, the Tif-Compression tool will a) 
backup the uncompressed Tif-file to filename_orig.tif and b) LZW-compress the image 
maintaining the original filename. After verifying the compressed Tif-files, the 
uncompressed backup copies (*_orig.tif) can be deleted to free up disk space. Because 
file compression is conducted directly on disk with gdal_translate, Tif-images of any file 
size can be compressed.  
 

1.1.7 Exit 

 
Quit the program and return to the operating system.  

https://doi.org/10.1080/01431161.2013.815382
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1.2. The General Tools pull-down menu  

 
The General Tools pull-down menu provides generic image processing utilities, which 
may be useful for a variety of purposes. The following options are available: 
 

➢ Preprocessing 

➢ Convolution 

➢ Equalization 

➢ Thresholding 

➢ Edge Enhance 

➢ Morphological 

➢ GIS Software 

➢ Switch Cursor 

➢ Undo/Redo 

 

1.2.1 Preprocessing 

 
The Preprocessing menu provides several generic image-processing routines targeted 
to reassign image pixel values. These routines can also be used for setting up MSPA-
compliant input images. The following options are available: 
 
➢ Convert → Byte/Integer/Long: convert the map data to the selected data type. 

 
➢ RGB → Single Band: convert an RGB-image into a single-band image. 

 
➢ Reproject for GoogleEarth: if the geo-header information of the currently loaded 

GeoTIFF file has a EPSG code and it is different to 4326 then this option can be 
used to reproject the image to EPSG:4326 (WGS 84). 

 
➢ Setup Batch Recode Table: define a recoding table from scratch or restore and 

modify an existing recoding table for later use. The recoding table shows the full 
Byte range of 256 values in [0, 255] with the new values in the left column and the 
old values to be recoded in the right column.  Please note that any new value in 
the cell of the left column will only be active after pressing the Enter key or after 
switching to a different cell of the left column. Once done, click the Save button to 
write the recode table to disk. Please use the naming convention 
GTBbatchrecode_*.sav (keep the prefix GTBbatchrecode_ and the file extension .sav and 
only modify the placeholder *). 
 

➢ Recode Classes: a table showing new and current unique pixel values is displayed. 
The new value entries in the left column can be reassigned to match the desired 
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recoding of image class values. The Set all to dropdown menu can be used to assign 
all classes to a single value. The Save button can be used to save a new recode 
table to a file GTBrecode_*.sav (please keep the prefix GTBrecode_ and the file 
extension .sav and only modify the placeholder *). Any previously saved recoding 
table GTBrecode_*.sav can be restored via the Restore button. Here, only those 
entries that match the current class values will be restored. This option is only 
available for images of data type Byte. Please note that any new value in the cell 
of the left column will only be taken over after pressing the Enter key or after 
switching to a different cell of the left column. 

 

Figure 2: Recode Classes GUI showing existing class values in the right column (Old) and new 
assignments in the left column (New). 

 
 
 

➢ Recode Pixel: this window allows assigning a new value to a specific pixel location. 
Please press the Enter key in each field to validate your input settings.  

Figure 3: Recode Pixel GUI 

 
 
 

➢ Recode Line: click on MSPA parameter 1 FGconn to activate the Recode Line 
option. It provides the ability to interactively draw a freehand (left mouse button) 
or straight line (right mouse button) as long as the mouse button is pressed. Upon 
releasing the mouse button, a new window allows assigning a specific value and 
the width of the line from a dropdown menu. 
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Figure 4: Recode Line GUI 

 
 

 
➢ Recode Region Of Interest (ROI): this option will open the full image in a new 

window: click the icons in the menu bar to draw, move or warp custom ROIs. A 
small popup window lists all custom ROIs shown in cyan color in the image with 
the currently selected ROI highlighted in red color. Please note that the ROI 
statistics are indicative, they will only be correct on very small images. Once all 
ROIs have been inserted, close the Define ROI interface, and assign the new value 
for all ROIs via the final popup window. The same procedure is applied to assign 
resistance values within the RESTORATION PLANNER. 

Figure 5: Recode ROI window showing various tools to draw custom ROIs (top) and region 
growing to select a given object outline (bottom left). Once defined, exit the window, and assign 
the new value for all ROIs (bottom right). 

 

 
 

➢ Threshold: FG/BG: apply a threshold to a gray-scale image to obtain a MSPA-
compliant binary image with foreground and background (FG and BG) values 
assigned to 1 and 2 byte, respectively. 
 

➢ Group: FG/BG/Missing: group a sequence of gray-scale image values into 
FG/BG/Missing. 
 

➢ X → FG/BG/Missing: assign an individual pixel value to FG/BG/Missing. 
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➢ Invert: exchange the current assignment of FG/BG/Missing. 

 
➢ Add 1b: add 1 byte to all current image pixel values. 

 
➢ Subtract 1b: subtract 1 byte of all current image pixel values. 
 
The Image Info box in the main window can be used to control the output of the 
Preprocessing functions or to query image properties. The box Original Image in the 
main window can be used to restore the originally loaded image. 
 

1.2.2 Convolution 

 
The Convolution menu offers the choice for one of the following image convolution 
filters: 
 
➢ Median: median filtering is effective in removing salt and pepper noise, (isolated 

high or low values).  The median is the middle value of a given data array, which 
should not be confused with the average value.  A set of predefined median filter 
box sizes is available in the submenu. 
 

➢ Boxcar: like Median, this filter computes the average value instead. 
 

➢ Lee: Lee filtering (Lee, 1986) will smooth additive image noise by generating 
statistics in a local neighborhood and comparing them to the expected values.  A 
set of predefined box sizes for the Lee filter is available in the submenu. 
 

➢ Sigma: this filter computes the mean and standard deviation of pixels in a box 
centered at each pixel of the image but excluding the center pixel.  If the center 
pixel value exceeds one standard deviation from the mean, it is replaced by the 
mean in the 5×5 box overlaying the pixel of investigation. 

 
➢ Hilbert: the Hilbert function outputs a series that has all periodic terms phase-

shifted by 90 degrees. This transform has the interesting property that the 
correlation between a series and its own Hilbert transform is mathematically zero. 
 

➢ User-Defined: a popup window allows the user to select or customize a kernel 
within dimensions within [3, 501] to be applied to the current image. The kernel 
size (ks) is an uneven number because it is measured with respect to the center 
pixel; for example, ks=5 corresponds to a moving window with x/y-dimensions of 
5 pixels (the center pixel ± 2 pixels in x/y-direction). Some predefined kernel sizes 
can be selected to analyze typical area measures A in [m2] at spatial resolution res 

in [m], in general: 𝑘𝑠 =
√𝐴

𝑟𝑒𝑠
 

For example, if we have satellite data with a spatial resolution of 25m and want to 
apply an analysis window area of 1,000 acres (4,046,856 m2) we need ks=81 



 15 

(
√4046856 

25
= 80.47, closest uneven number is 81), or you insert your custom size, 

i.e., an analysis window of 1km2 on satellite data having 30m resolution: ks=33 

(
√1000000 

30
= 33.33, closest uneven number is 33). 

 

Figure 6: Define Kernel interface showing options to define the kernel dimension within the range 
[3, 501], select a square and/or a binary kernel and a reset option to go back to the default kernel 
for the current application. 

 
 
 
 
 
 
 
 

1.2.3 Equalization 

 
The Equalization menu offers the choice for one of the following image processing 
algorithms: 
 
➢ Contrast: the image contrast can be adjusted in an interactive mode. This option 

will close the main window and open a new, dual window interface (FIGURE 7). 
The window on the left displays the histogram of the brightness values of the 
image and two color-bars, which can be dragged with the mouse to set a lower 
and upper limit for the intensity range into which the image will be rescaled. The 
result of this procedure is shown in the preview window on the right, which can 
be saved in a variety of image formats from the Controls → Save image as menu.  
Furthermore, the maximum pixel density may be reset from the Controls → Max 
pixel density menu to display the histogram in an adequate way. Finally, choosing 
Quit/Accept will close this interface, return to the main interface, and cancel/apply 
the selected settings to the current image. 
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Figure 7: Contrast interface showing on the left the histogram of the brightness values including 
the two color-bars to define the contrast range; and on the right the preview of the selected 
contrast range applied to the current image.  

 
 
➢ Histogram Equalization: this function is used to obtain the density distribution of 

the input array. The histogram is integrated to obtain the cumulative density-
probability function and a histogram-equalized image is returned. 
 

➢ Adaptive Histogram Equalization: this function applies contrast enhancement 
based on the local region surrounding each pixel. Each pixel is mapped to an 
intensity value, which is proportional to its rank within the surrounding 
neighborhood. 

 
 
 
 
 
 
 
 

1.2.4 Thresholding 

 
This option will open a dual window (FIGURE 8). The left window displays a histogram 
of the brightness values from the current image. A color bar indicating the current 
threshold value can be moved with the mouse to set a new threshold value, which is 
displayed in the right window of this interface. The Controls menu provides the option 
to save the current preview to an image in a variety of image formats and to redefine 
the maximum pixel density to best display the brightness value distribution of the 
histogram. Finally, the Quit or Accept buttons are used to cancel/apply the selected 
threshold. Please note that this process results in a binary image and can therefore 
only be applied once. 
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Figure 8: Thresholding interface with a color bar to set and preview a brightness threshold value on 
the current image. 

   

The result of using this interface is a binary image having foreground and background 
(FG/BG) values assigned to 0/1 byte, respectively. This is different to the option in 
Preprocessing → Threshold where the resulting binary image is MSPA-compliant 
having foreground and background (FG/BG) values assigned to 1/2 byte. 

 

 

 

 

 

 

 

 

 

1.2.5 Edge Enhance 

 
This Edge Enhance menu provides a series of edge enhance filters, which are described 
in the following: 
 
➢ Canny: this filter produces results like the Sobel operator, but is separable (Canny, 

1986).  This means that it can be performed in two passes, computing the 
derivative in the horizontal and the vertical direction.  They are then combined to 
calculate the gradient or the difference of the two components.   

➢ Laplace: the image is convolved with the kernel: 
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➢ Roberts: the diagram below shows the principle of the Roberts operator (1965) 
where two differences in orthogonal directions are combined to determine the 
gradient.  
 

      
 

➢ Sobel: like the Roberts filter, the Sobel filter computes the derivatives in two 
orthogonal directions, which are combined as the square root of the sums of their 
squares to obtain a result independent of orientation. 
 

➢ Sharpen: this filter adds the Laplace filter of the image to the image itself. The 
Define Kernel window (FIGURE 6) offers the option to use a different user-defined 
filter. 
 

➢ Unsharp masking: this filter subtracts the original image from a smoothed version 
of the original image. Different smoothing box sizes are selectable from the 
submenu.  
 

➢ Skeleton: this filter combines thresholding with the Sobel filter.  
 
 
 
 
 
 

1.2.6 Morphological 

 
Mathematical morphology is a methodology of analyzing digital image objects based 
on their shape attributes. A discussion of this topic is beyond the scope of this manual. 
A suggested reference is Soille, 2004; In short, a user-selectable object of a given size 
and shape (structuring element) is defined and the image is scanned for the presence 
or absence of this shape of interest (some examples in TABLE 1). This option will open 
a new window (FIGURE 9) providing a series of morphological filters (Dilate, Erode, 
Open, Close, Tophat, Gradient), structuring element types (horizontal, vertical, 
diagonal up, diagonal down, circular) and sizes (1-10). Any combination of filter and 
structure type and size can be selected and tested by pressing the Test button in the 
upper panel. The Define kernel window (FIGURE 6) allows for selection of the default 
or user-defined kernel to be applied to the previously selected settings. The result of 
this process is displayed in the graphical display of this window. Other combinations 
may be tested at any time after restoring the original state in the display via the Reset 
button. When using the Tophat-filter, the contrast of the resulting image can be 

https://doi.org/10.1007/978-3-662-05088-0
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adjusted with the sliders in the horizontal panel above the display. Finally, the 
Quit/Accept button will close this window and cancel/apply the selected filter settings 
to the current image in the main window.  
 
Figure 9: Morphological filter interface showing a preview for a variety of combinations of filters with 
structuring element type and sizes. 

 
 
 

Table 1: Description of some basic morphological filters. 

Filter Description 
Dilate fills holes of size equal to or smaller the structuring element. 

Erode removes islands smaller than the structuring element 
Open an erosion followed by a dilation; pixels are removed 

Close a dilation followed by an erosion; pixels are added 

Tophat = image–open(image): Shows brightness peaks on inverted image 

Gradient = dilate(image)–erode(image): Highlight structure boundaries 
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1.2.7 GIS Software 

 
The GIS Software menu provides access to the following GIS related software packages 
on the host PC running GTB: 
 
➢ GTB Terminal: this option will open a separate terminal to access all GDAL-

commands.  Use this terminal to work on your data, for example to reproject 
(gdalwarp), format conversion (gdal_translate), get information (gdalinfo), and much 
more.  

 
➢ OpenEV Viewer: this option will open a separate window with the image viewer 

OpenEV, which is only available in the MS-Windows version of GTB.  
 
➢ QGIS: this option will open QGIS if it is found in the operating system. 
 
 
 
 
 
 
 

1.2.8 Switch Cursor 

 
This option can be used to change the appearance of the mouse cursor within the GTB 
viewport.  
 
 
 
 
 
 

1.2.9 Undo/Redo 

 
GTB stores the settings of one (1) processing step only. The Undo button may be used 
to undo the last processing step. If selected, this button will change to Redo allowing 
reverting to the previous step. 
 
 
 
 
 
 

https://gdal.org/programs/index.html
https://gdal.org/programs/index.html
https://qgis.org/
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1.3. The Image Analysis pull-down menu 

 
All image analysis modules under this section are grouped into dedicated thematic 
containers and have been developed to address specific questions. The section itself 
as well as each container are briefly summarized with an introduction named 
Overview. Please have a look at this overview, the respective sections in this manual, 
and the mentioned product sheets to better understand the scope and usage of each 
image analysis module.  
The Image Analysis pull-down menu provides the following thematic containers: 
 
➢ Objects 

➢ Pattern 

➢ Network(MSPA) 

➢ Fragmentation 

➢ Distance 

➢ Restoration Planner  

 

1.3.1 Objects 

 
This menu provides several options for the analysis of individual image object 
attributes.  
 
 

1.3.1.1 Accounting 

 
The Accounting option will label and calculate the area of all foreground objects 
(coded with 2 byte) according to user-specified area thresholds: 

Figure 10: Accounting interface showing user-selectable fields for Foreground Connectivity, Pixel 
Resolution, Big3pink and up to six foreground-object size classes. 

 
 
FIGURE 10 shows the Accounting interface where in the top row, the user should 
specify the Base Settings (Foreground Connectivity, Pixel Resolution, Big3pink: show 
the largest three objects in pink – no/yes). In the center row, select or insert custom 
values to define the area thresholds (in pixels) of up to six object size categories. The 
bottom row shows the spatial pixel resolution retrieved via the gdalinfo command. 
Depending on the geoheader, it might be in meters, degrees, any other unit, or not 
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available at all and for this reason should be considered for information only. The 
initial 5 area thresholds are derived by GTB by calculating the range from the smallest 
to the largest object area and scaling the range into 5 sections starting from the 
smallest object area + [0.001, 0.01, 0.1, 0.5, 0.9]*range. Use the Reset button to re-
assign the initial automatic scaling thresholds. The Save and Restore button saves or 
restores custom user settings.  The area interval of Class 1 starts with the smallest 
object area up to and including the area threshold specified by the user. The following 
Classes start at the area threshold of the previous Class + 1 pixel up to the Class 
threshold. Class 6 accounts for all objects larger than the area threshold of Class 5. The 
interface will automatically adjust the thresholds to ensure a positive progression of 
the threshold settings. Neighboring classes can be collapsed into a single class by 
assigning the same area threshold value. Combined with the pixel resolution, the two 
bottom rows show the upper area limit of each class in hectares and/or acres. Please 
note that this information is only valid when using an image having an equal area 
projection and a properly specified information on the pixel resolution.  
Via the Accounting interface, the user can set each area threshold to define specific 
area classes in pixel, hectare, or acre. To apply the user-defined settings press the 
Accept button. 
 

Figure 11: Accounting result showing different area categories in different colors and a statistical 
summary for the number of objects, their area, and proportions in up to six different area classes 
and highlighting the 3 largest objects in pink color, if the switch Big3pink was set to 1. 

 
 
The result is an image showing all objects in up to six different area classes, each with 
its own color, background in grey and potential missing data in white. In addition, the 
three largest objects are highlighted in pink color, if the switch Big3pink was set to 1. 
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Moving the mouse cursor over an object will show the object ID and its area in the 
information panel below the viewport. For example, in FIGURE 11 the mouse cursor 
is over the green object at the position 154/1676, the unique object ID is 16 and the 
area of object 16 is 73,827 pixels, thus falling into size class 6, shown in green color. 
 
Saving an Accounting image will produce a directory with files having the prefix 
<name>_acc: 
a) prefix.tif: same graphics as displayed in GTB 
b) prefix.txt (only when saving the entire image): a table listing the number and area [in 
pixels] for the objects per size class (see FIGURE 11). 

 
In batch mode, the user can select to add the following optional two files: 
c) prefix_ids.tif: the unique identifiers of the objects in positive integer values and pixel 
values for Background (0), Missing (-1), Water (-3 in input data, Special Background 1), 
SpecialBG (-4 in input data, Special Background 2). 
d) prefix_pixels.tif: the area in pixels for each object plus the following fixed values for 
Background (0), Missing (-1), Water (-3 in input data, Special Background 1), SpecialBG 
(-4 in input data, Special Background 2). 
More information is available in the Accounting Product Sheet.  
 
When running Accounting in batch-mode, no automatic scaling settings are calculated, 
and the user-selected settings are applied to all input images regardless of their actual 
object area range and/or pixel resolution. 

 
 
 

1.3.1.2 Parcellation 

 
On a given categorical map, Parcellation provides a summary of number, area, and 
some simple metrics for each class as well as the entire image (see TABLE 2 below) 
with: 
ai,j = area of object i in class j  
n = number of unique objects in each class 
Aj = total area of a given landcover class j 
A = image data area: all classes in the image = image – missing pixels 
 
Parcellation provides a statistical summary file (txt/csv-format) with details for each 
unique class found in the image: class value, total number of objects, total area plus 
the full image summary, (see TABLE 2 below): 

• Class: sequential number of individual landcover classes 

• Value: landcover class value in the image 

• Count: total number of patches in the given landcover class j 

• Area: total area of a given landcover class j:  
  Aj (Unit: area, measured in pixels) 

• APS: Average Patch Size of a given landcover class j: 

https://ies-ows.jrc.ec.europa.eu/gtb/GTB/psheets/GTB-Objects-Accounting.pdf
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 APS =
1

𝑛
∗ ∑ 𝑎𝑖,𝑗

𝑛

𝑖=1
 (Unit: area, measured in pixels) 

• AWAPS: Area Weighted APS of a given landcover class j: 

 AWAPS =
1

𝐴𝑗
∗ ∑ 𝑎𝑖,𝑗

2𝑛
1   (Unit: area, measured in pixels) 

• AWAPS/data: AWAPS with respect to the entire data area A: 

 AWAPS =
1

𝐴
∗ ∑ 𝑎𝑖,𝑗

2𝑛
1   (Unit: area, measured in pixels) 

• DIVISION: degree of division of a given landcover class j: 

 DIVISION = 1 − 𝑆 = 1 − ∑ (
𝑎𝑖,𝑗

𝐴𝑗
)

2
𝑛
1   (Unit: index in [0, 1]) 

• PARC: a logarithmic conversion and normalization of the Division complement 𝑆 =

∑ (
𝑎𝑖,𝑗

𝐴𝑗
)2𝑛

1 : 

a) convert/constrain 𝑆 into the range 𝑅 = [− ln(1.0𝑒−6) ≤ −ln(𝑆)] 

b) normalize: 𝑃𝑎𝑟𝑐 =
100

− ln(1.0𝑒−6)
∗ 𝑅  (Unit: index in [0, 100]%) 

 
The final line (TABLE 2) provides the overall summary for the entire image, top-left 
image in FIGURE 12: the parcels were investigated using the 8-connectivity rule: there 
are 26 individual classes and 967 individual objects. The total area of all objects (= data 
area) is 4,000,000 pixels, the Average Patch Size (APS) is 4,136 pixels, the Area 
Weighted Average Patch Size (AWAPS) is 450,657 pixels, and the degree of division is 
0.8873 corresponding to a Parcellation (PARC) for the entire image of 15.8%. 
 

Table 2: Example for tabular statistics of Parcellation. 

 
 

The MSPA parameter 1 FGconn can be used to set the 4 or 8-connectivity rule for the 
image objects. The input image for the Parcellation analysis must be a raster map with 
at least two landcover classes. A class value of 0 (zero) is reserved for masking no-data 
pixels. 
In general, the value of Parcellation will increase with increasing number of feature 
classes, number of objects per class, and decreasing object areas. 
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Figure 12: Example images showing: the number of image objects (blue), the number of individual 
classes (black) and the value of Parcellation (red). Results of the top (bottom) row below each 
image correspond to using the 4- (8-) connectivity rule for the image objects. 

 
 
The left image of the top row in FIGURE 12 shows a CORINE landcover image of 
dimension 2,0002 pixels having a total of 26 individual landcover classes. When using 
the 4-connectivity rule the image is composed of 979 parcels. When adding the 
diagonal direction of the 8-connectivity rule some neighboring parcels of the same 
landcover type become combined resulting in a lower total of 967 individual parcels. 
TABLE 2 provides further details for the latter case on the relative Parcellation of each 
landcover class. The next three examples in the top row of FIGURE 12 show the effect 
of joining the existing 26 landcover classes into 3, 2 and finally a single landcover class: 
the decrease of the total number of parcels and classes is directly related to the value 
of Parcellation and reaching the minimum at the lower boundary condition 
represented by a fully homogeneous landcover. However, this expected behavior is 
different when a substantial number of missing pixels or no-data areas are present in 
the image, represented in the black color in the first two images of the bottom row in 
FIGURE 12: assigning all parcels into a single landcover class or each parcel into a 
different one should not, and in fact it does not change the Parcellation value of the 
image data area. This behavior is also evident from the Parcellation formula, which is 
simply building the sum of the relative contribution of each parcel over each landcover 
class. The third image in the bottom row of FIGURE 12 shows a random distribution 
of two landcover classes generated for an image size of dimension 10242 pixels. The 
purpose of this image is to illustrate the potentially strong impact of applying the 4- 
or 8-connectivity rule, here resulting in a drastic difference in the total number of 
parcels and the Parcellation itself. Obviously, this behavior is very pronounced when 
only 2 classes are present, resulting in a high probability of the same landcover class 
being present in a diagonal neighborhood. The probability to encounter the same 
landcover class in the direct neighborhood is far less with more classes present in the 
image. The final image in FIGURE 12 confirms this thought showing a very similar 
number of parcels and Parcellation on an image of dimension 4002 pixels and being 



 26 

composed of 500 individual classes in a random distribution. A further increase in the 
number of individual classes will obviously increase the value of Parcellation up to the 
boundary condition of 100% when each pixel has its own individual class value. 
More information can be found in the Parcellation Product Sheet.  
 
 

1.3.1.3 Contortion 

 
Contortion describes the degree of regularity of a foreground object perimeter. Its 
value corresponds to the number of times a given object perimeter direction changes 
its sign.  
 

Figure 13: Contortion: measuring the number of directional changes in x-/y-direction. 

 
 
Contortion can be used for shape description to distinguish random shapes from 
regular shapes. This is achieved by following the entire perimeter line, which includes 
the final angle at the starting point. FIGURE 13 shows a sketch of the raster 
representation for a series of simple objects. Starting at the lower left border point, 
and following the entire perimeter outline of the object, the number of the directional 
changes in the X-/Y-direction are shown in white boxes. The final Contortion value for 
each object is shown in a red box while the number of perimeter corner counts is 
shown in a blue box. For example, when following the perimeter of a rectangle the 
direction changes one time in the horizontal and one time in the vertical direction: the 
contortion of a rectangle is 2, regardless of the orientation of the rectangle in the 
rectangular grid representation (see left part of FIGURE 13). Similarly, the contortion 
of the letter E is 6. An important feature of contortion is the invariance with respect 
to the length of diagonal lines. For example, two triangles oriented in the same 
direction but of different size will have a different number of pixel corners points due 
to the staircase representation along the diagonal lines. However, they both have the 
same contortion value of 2. The same is true for circles of different size. In satellite 
images, regularly shaped objects such as buildings and agricultural fields will have low 

https://ies-ows.jrc.ec.europa.eu/gtb/GTB/psheets/GTB-Objects-Parcellation.pdf
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contortion values while natural objects are more likely to be non-regular and hence 
have higher contortion values. 
Since contortion investigates the object perimeter, contortion will be calculated only 
on objects having a core area. In addition, the user can define a minimum object area 
to be considered for the calculation via the MSPA parameter 2 EdgeWidth drop-down 
menu. Either select a pre-defined value or specify a custom value in the first entry of 
the drop-down menu. Pressing the Enter key will then apply the new custom minimum 
area value and recalculate the contortion. In the resulting image, small, neglected 
objects are denoted as omitted and displayed in black color. The title bar shows the 
fraction of calculated versus total number of foreground objects in the image. The 
Divide Range panel below the GTB viewport can be used to group the contortion value 
range into small/medium/large using either pre-defined or custom values in the 
respective threshold drop-down menu.  
 
 

1.3.2 Pattern 

 
This menu provides access to the following pattern analysis tools: 
 
 

1.3.2.1 Morphological  

 
This option will process the user-selected file using the following options:  

 
➢ SPA2: this option will process a binary input image resulting in a simplified version 

of the full MSPA with a map and statistics for two (2) morphological classes: 
Contiguous areas and small/linear features (SLF), see FIGURE 14. SPA2 input 
images are not subject to the MSPA input image size limitations. 
The main purpose of SPA2 is to delineate small/linear features from contiguous 
foreground objects. 

 
➢ SPA3: this option will process a binary input image resulting in a simplified version 

of the full MSPA with a map and statistics for three (3) morphological classes: The 
two foreground classes Core and Margin plus the background class Core-Opening, 
see FIGURE 14. SPA3 input images are not subject to the MSPA input image size 
limitations.  
The main purpose of SPA3 is to focus on Core, non-Core and Core-Openings only. 

 
➢ SPA5: this option will process a binary input image resulting in a simplified version 

of the full MSPA with a map and statistics for five (5) morphological classes: The 
four foreground classes Core, Edge, Perforation, Margin plus the background class 
Core-Opening, see FIGURE 14. SPA5 input images are not subject to the MSPA 
input image size limitations. 
The main purpose of SPA5 is to provide more details compared to SPA3 by adding 
information on the internal and external Core-boundaries. 
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➢ SPA6: this option will process a binary input image resulting in a simplified version 

of the full MSPA with a map and statistics for six (6) morphological classes: The five 
foreground classes Core, Edge, Perforation, Islet, Margin plus the background class 
Core-Opening, see FIGURE 14. SPA6 input images are not subject to the MSPA 
input image size limitations. 
The main purpose of SPA6 is to provide more details compared to SPA5 by adding 
information on isolated small fragments, which are too small to contain Core area. 
 

Figure 14: Simplified Pattern Analysis (SPA) including coherent areas and small/linear features 
(top-left), detection of holes inside Core and providing a total of 3-classes (top-right), 5-classes 
(bottom left) and 6-classes (bottom-right). 

 
Compared to MSPA, SPAx may provide different results along image boundaries 
due to a simplified treatment of image border pixels. More information can be 
found in the Morphology Product Sheet.  

 
➢ MSPA: this option will process a binary input image using the mathematical 

morphology algorithm described in Soille & Vogt, 2009 and Soille & Vogt, 2022. 
Compared to SPA2/3/5/6 the full version of MSPA provides many more 
morphometric details of the foreground patches as well as detecting holes along 
foreground boundaries. The 10 classes shown in FIGURE 15 are only the visual 
result while the numeric result can provide details on up to 23 different 
morphometric classes. The full MSPA version has many additional features to fine-
tune the analysis, for example, using the 4- or 8-connectivty rule for the 
foreground pixels, using an EdgeWidth larger than 1 pixel, showing transition 
pixels of connecting pathways and distinguishing background within from 
background at the boundary of foreground. Further details on input requirements, 
processing options, resulting pixel values and morphological classes are 
summarized in the dedicated MSPA GUIDE or Online. This document provides 
information on the operating system specific MSPA input image file size 
limitations, also available in the Help → ABOUT GTB  menu.  

https://ies-ows.jrc.ec.europa.eu/gtb/GTB/psheets/GTB-Pattern-Morphology.pdf
https://doi.org/10.1016/j.patrec.2008.10.015
https://doi.org/10.5194/isprs-archives-XLVIII-4-W1-2022-427-2022
https://forest.jrc.ec.europa.eu/en/activities/lpa/mspa/
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Selecting MSPA statistics will conduct summary statistics for the foreground pixels 
and the openings within foreground, more details can be found in the section 
MSPA STATISTICS.  
 
Standalone MSPA-plugins with documentation and installers are also available for 
ArcGIS, R, and QGIS from the MSPA-website. 
The main purpose of MSPA is to provide additional details on connecting pathways, 
branches, and internal features and a user-selectable, scale-specific spatial pattern 
analysis. 
 

Figure 15: MSPA: overview of the various foreground and background MSPA pattern classes 
derived from a binary input mask (9 → 23 classes, connecting pathways, variable edge width, and 
additional fine-tuning options). 

 
 

 
➢ MSPA Tiling: this option will perform a MSPA-analysis with an automated buffered 

tiling of a single image which is larger than the maximum file-size (MS-Windows: 
10,0002 pixels; Linux/macOS: larger than 10,0002 pixels depending on the available 
free RAM). After verifying MSPA-compliance, a window will open, where the MSPA 
parameters can be specified but with the fixed edge width = 1. No statistics will be 
calculated for these large images. If statistics are needed, first process the image 
via MSPA Tiling, then load the result into GTB, where it will be recognized as a 
MSPA image, and then click the MSPA Statistics checkbox.  
Important note: MSPA-tiling is a less than ideal and time-consuming solution, 
which is not guaranteed to provide exact results. We strongly recommend using 
GWB for MSPA processing of large images! 
 
 
 

 
 
 

https://forest.jrc.ec.europa.eu/en/activities/lpa/mspa/
https://forest.jrc.ec.europa.eu/en/activities/lpa/gwb/
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1.3.2.2 Moving Window  

 
This menu provides access to several moving window (convolution) algorithms, 
implemented via the generic image-convolution program spatcon.c (K. Riitters, 
personal communication, 2015; and demonstrated in earlier papers: Riitters et al. 
1997, 2000, 2002, 2009). SpatCon metrics conduct focal statistics within a user-
defined neighborhood area over each pixel of the input image. 
Image convolution (Gonzalez and Woods, 1992), also known as moving window, is a 
general process that can be used for various types of smoothing, signal processing, 
shifting, differentiation, edge detection, etc. It places a window (kernel) on each pixel 
of the input map, calculates the pattern metric within the window, and puts the result 
on a new map at the same location. The value of the resulting index is driven by the 
dimension and the individual weights assigned to the window elements.  
Think of it as opening an umbrella over a foreground pixel, do the assessment for the 
area covered under the umbrella (local neighborhood), and assign the result to the 
center pixel of the umbrella in the output map. The process is repeated over each 
foreground pixel, hence the term moving window, and illustrated at four example 
locations using a 3x3 neighborhood (umbrella) in the following chart: 
 

Figure 16: Moving window analysis: a moving window of size n x n (here, 3x3) is centered over a 

given foreground pixel, the metric is calculated, and the resulting value is assigned to the same 

location in the output map. The central panel shows four example locations to illustrate the process. 

 
 
FIGURE 16 shows an example of a map of 10x10 pixels with foreground pixels in green 
color. The central panel shows the application of a moving window analysis using a 
3x3 window/umbrella. For the area covered by the umbrella, the metric Foreground 
Area Density (FAD), equivalent to the amount of foreground area relative to the 
moving window area, is assigned to the central location of the umbrella in the output 
map. After repeating these steps for all foreground pixels, the result of the 
computation is shown on the right panel, having identical pixel coverage as in the input 
map but now showing the degree of FAD for each foreground pixel and considering a 
local neighborhood of 3x3 pixels. Increasing the dimension, or size of the moving 

https://desktop.arcgis.com/en/arcmap/latest/tools/spatial-analyst-toolbox/how-focal-statistics-works.htm
https://en.wikipedia.org/wiki/File:2D_Convolution_Animation.gif
https://en.wikipedia.org/wiki/Kernel_(image_processing)
https://docs.gimp.org/2.8/en/plug-in-convmatrix.html
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window, implies accounting for a larger local neighborhood area or using a larger 
analysis/observation/reporting scale. 
Via an initial pop-up window, the user can specify the size of a square (kernel) window, 
which is then overlaid over each pixel of the input image, the selected metric is 
calculated for the area of the window, and the result is re-assigned to the center pixel 
of the overlaid window in the output image. All texture metrics are derived from 
analyzing the attribute adjacency table (Musick and Grover 1991), where Fij (i, j = 1 to 
t) is the frequency of adjacent pixel pairs with land-cover types {i, j}. When forming 
the attribute adjacency table, adjacency is evaluated in the four cardinal (horizontal 
and vertical) directions, each adjacency is counted once, the order of pixels in pairs is 
not preserved, and pairs involving a missing pixel are not included (Riitters et al. 
1996b).  
 

Figure 17: Illustration of moving window metrics (as implemented in SpatCon).  

 
 
FIGURE 17 shows a sample landcover map with four landcover classes (top left) and 
the associated attribute adjacency table (bottom left), which is derived from counting 
the landcover classes in cardinal directions of each pixel boundary. For example, a 5x5 
map has a total of 40 adjacencies and we consider foreground (forest) adjacencies 
only. The top line of the attribute adjacency table in FIGURE 17 shows that we have 
a total of 33 adjacencies having forest on at least one side of the pixel boundary. From 
those 33, 12 adjacencies have forest on both sides of the pixel boundary, 15 
adjacencies have forest on one side and developed on the other side of the pixel 
boundary, 3 adjacencies have forest on one side and agriculture on the other side of 
the pixel boundary, and 3 adjacencies have forest on one side and water on the other 
side of the pixel boundary.   
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The image-convolution program spatcon.c offers a series of moving window metrics. 
Note: GWB includes all 21 SpatCon metrics in the dedicated module GWB_SC. GTB 
offers access to four SpatCon moving window metrics only, which can be grouped in 
two categories:  
 

• Pixel counting metrics (measuring density): the density metrics Landscape 
Mosaic and Density are calculated from the proportions of pixel values in the 
window. For those metrics, missing pixel values are not included in the 
calculation, and the calculation result is missing if all pixels in the window are 
missing. 
 

• Adjacency counting metrics: all adjacency metrics are calculated from the 
pixel|pixel adjacency values in the window. We define N as the total number 
of adjacencies between all pixels in cardinal directions, and the subset n as the 
number of adjacencies that have foreground on one side or the other. All 
adjacencies (N-n) that do not have foreground on either side are excluded in 
the metric calculation. If there are missing pixels in the (kernel) window, the 
adjacencies involving missing pixels are not included. As a result, the total 
number of adjacencies is less than N and the total number of adjacencies 
involving foreground may be less than n, if missing pixels are adjacent to 
foreground pixels. Clustering is landscape-level contagion, the denominator is 
the number of all adjacencies of the moving window. Contagion is class-level 
contagion (one row of the attribute adjacency table), the denominator is the 
number of foreground adjacencies only.  
 
 
 

 
The following moving-window processing options are available in GTB:  

 
➢ Landscape Mosaic (FIGURE 18): a tri-polar classification of a location accounting 

for the relative proportions of three classes in the window surrounding that 
location. The classification model uses the critical values of 10%, 60%, and 100% 
along each axis to partition the tri-polar space into 19 mosaic classes. More details 
on the concept of Landscape Mosaic and application examples can be found in 
Wickham et al. (1994) and Riitters et al. (1996a, 2000, 2009).  
The result of the moving window analysis is a geographic map showing the 19 
landscape Mosaic classes for each pixel at the user-selected observation scale 
(FIGURE 19, left). A second output shows a statistical summary as a heatmap 
(image and csv-file). The statistical summary is for an expanded, 103-class version 
of LM with the LM image pixel value assignment detailed in FIGURE 20. In this 
expanded version, each of the 100 sub-triangles in FIGURE 19 is a separate class, 
and three additional classes correspond to the external circles (AA, DD, NN in 
FIGURE 19). The heatmap image (FIGURE 19, right) shows the relative 
frequencies of pixels in each of the 103 categories (see also FIGURE 21). The 
accompanying csv-file contains the numeric values from the heatmap image.  

https://github.com/ec-jrc/GWB/tree/main/tools/external_sources
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Figure 18: Landscape Mosaic (LM) tri-polar classification scheme showing 19 mosaic classes and 
their proportions of the 3 landcover categories Natural, Agriculture, and Developed. A capital 
letter denotes more than 60% and a small letter a contribution in the range of [10-60]% of a given 
landcover category. 

 

 

 

Figure 19: Landscape Mosaic (LM) image (left) and corresponding heatmap (right) showing LM-
pixel occurrence frequencies. The maximum frequency is highlighted in a black circle. In this 
example, 21% (i.e., 17% plus 4%) of all LM-pixels are in the Mosaic class A (Agriculture). 
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Figure 20: Image pixel value assignment of the 103 LM-classes. 

 
 

Figure 21: Explanatory chart to read out Landscape Mosaic pixel value triplets and to locate 
these triplets in the ternary domain space.  
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Figure 22 shows how the 103-class LM image can be displayed with different 
predefined color tables to focus on a specific thematic topic of interest. Simply 
load the 103-class LM image and select the color table of your choice from the 
Select Colortable dropdown menu: LM_AGR, LM_NAT, LM_DEV, LM_BGR, 
LM_DIV, or LM_ANT. Alternatively, define a custom color table to highlight a 
particular section of the ternary LM-chart.  

 

Figure 22: Example of color-coding the 103 classes of the Landscape Mosaic over Atlanta, GA, 
USA. LM-Agriculture, LM-Natural, LM-Developed showing dominance of agricultural, natural, 
and developed land cover, respectively. LM-Background (predominant land cover type), LM-
Diversity (degree of heterogeneity), LM Anthropic (anthropogenic intensity). 

 

 
 
The input image for Landscape Mosaic must be a Byte array with no more than 3 
target classes with the assignment AND (1-Agriculture, 2-Natural, 3-Developed) 
plus an optional class for missing values (0 Byte).  
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More information can be found in the LM Product Sheet. 

Note: GTB provides the additional option Dominance, which combines LM-analysis 
over a set of five observation scales into a summary layer showing the dominant 
triplet of landcover type across multiple observation scales. 

 

➢ Density (or Foreground Area Density - FAD): the proportion of foreground pixels 
(2b) in the moving window. More details on the concept of Density and Contagion 
(see below) and application examples can be found in Riitters et al. (1997, 2002, 
where Density=Pf and Contagion=Pff). Click Intext for FG-masking and Divide for 
range grouping. The input image for Density must be MSPA-compliant: A Byte 
array having 0b – missing (optional), 1b – background, 2b – foreground. The output 
map is a byte image showing the proportion of foreground density within [0, 100]% 
and masked by foreground, background (101 byte) and missing pixels assigned to 
102 byte. 

 

➢ Clustering (or Foreground Area Clustering - FAC): foreground clumpiness at 
landscape level. The reference level for Clustering are all adjacencies within the 
area covered by the moving window/umbrella. Clustering measures the 
proportion of adjacencies in cardinal directions for which both pixels are 
foreground (2b|2b) with respect to all adjacencies in the moving window. Click 
Intext for FG-masking and Divide for range grouping. The input image for 
Clustering must be MSPA-compliant: A Byte array having 0b – missing (optional), 
1b – background, 2b – foreground. The output map is a byte image showing the 
normalized degree in foreground clustering within [0, 100]% and masked by 
foreground, background (101 byte) and missing pixels assigned to 102 byte.   

 

➢ Contagion: foreground clumpiness at class level. The reference level for Contagion 
is limited to all forest adjacencies within the moving window/umbrella. Contagion 
measures the proportion of adjacent pixel pairs in cardinal directions that include 
at least one foreground pixel, for which both pixels are foreground (2b|2b). 
Contagion estimates the conditional probability that, given a foreground pixel, its 
neighbor is also foreground. Click Intext for FG-masking and Divide for range 
grouping. The input image for Contagion must be MSPA-compliant: A Byte array 
having 0b – missing (optional), 1b – background, 2b – foreground. The output map 
is a byte image showing the normalized degree in foreground contagion in [0, 
100]% and masked by foreground, background (101 byte) and missing pixels 
assigned to 102 byte.  

 

 
 
 
 

https://ies-ows.jrc.ec.europa.eu/gtb/GTB/psheets/GTB-Pattern-LM.pdf
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1.3.2.3 GraySpatCon 

 
The image-convolution program GraySpatCon (GSC) offers a wide variety of texture 
metrics for the analysis of dichotomous (binary), nominal, and ordinal raster data. The 
metrics are based on the frequency of pixel values and/or the frequency of pixel value 
adjacencies in a moving window and measure either the attraction or the dispersion 
of numerical pixel values on a map. The input map requirements, GSC metrics, 
parameters, processing options, and output specifications are summarized in the GSC 

Guide (Help → GTB Documentation → GSC Guide) and can be configured in a 
dedicated popup window: 
 

Figure 23: GraySpatCon popup window  

 
 
For a global analysis, the result is a plain text file listing the GSC-parameters used and 
the global metric value. For a moving window (non-global) analysis, the result is a set 
of two files: a) a plain text file with the GSC-parameters used, and b) a (Geo)TIFF 
formatted image showing the selected metric value at pixel level and in the format 
specified by the GSC processing parameters. The GSC-metrics are calculated as 
integer, nominal, or floating-point values. For the metrics which are floating-point 
values, GraySpatCon rounds the calculated value to 5 decimal digits (0.00005) for 
output of either float values or rescaled byte values. 
 
For 8-bit (byte) output the missing value is always 255. For 32-bit (float) output, the 
missing value is -0.01, except for metrics 44, 45, and 50 that may take on a negative 

value, in which case the missing value is -9000000.0. The switch  Missing → NaN, see 
right panel in FIGURE 23, provides the following two options: 

• Yes: will assign all NODATA pixels the value of NaN. This step will resolve output 
display issues and show consistent results across all image viewers. When saving a 
GraySpatCon image, GTB will write out the original GraySpatCon value for those 
pixels that were manually assigned to NaN via the GTB popup window. 

• No: will use the unmodified GraySpatCon output image. When saving a 
GraySpatCon image, GTB will add the respective NODATA information in the 
GeoTIFF header.  

With either of these options, any user can then make necessary adjustments to amend 
the missing data value to either, the original GraySpatCon value or any other value 
that is suitable for the image viewer software application. 
 
  

https://github.com/ec-jrc/GWB/tree/main/tools/external_sources
https://github.com/ec-jrc/GWB/tree/main/tools/external_sources
https://github.com/ec-jrc/GWB/tree/main/tools/external_sources
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1.3.3 Graph Theory Network: GTN(MSPA) 

 
The MSPA-analysis can be converted into a Graph Theory Network (GTN) setup for 
further analysis in a graph theory application, here Conefor (Saura, 2009a). A Graph 
Theory Network (GTN) is composed of Nodes (↔ MSPA class: Core) and Links (↔ 
MSPA class: Bridge = connectors between different Cores) and the remaining MSPA 
classes are neglected. A connected set of Nodes and Links is called a Component.  

Figure 24: Relation between MSPA and Graph Theory 

 
 
FIGURE 24 shows the relation between MSPA and graph theory. The network 
illustrated above has one component, which is composed of four Nodes and four Links. 
The Nodes correspond to the MSPA class Core and the Links to the MSPA class Bridge. 
All other MSPA classes are neglected for graph theory analysis, for example the MSPA 
features Edge, Perforation, Loop, Branch, and Islet are removed when transitioning to 
a graph theory network. In addition, a graph theory Link (MSPA Bridge) is a feature 
without area. 
 
The following GTN options are available after a MSPA-analysis: 
 
 

1.3.3.1 GTN Components 

 
Individual components of the graph theory network are displayed in alternating colors. 
The color black is used for node-only components having no links. The ECA, Equivalent 
Connected (Node/Core) Area, (Saura et al. 2011) is the square root of 

PCnum=∑ (𝑛𝑜𝑑𝑒 𝑎𝑟𝑒𝑎 𝑜𝑓𝑐𝑜𝑚𝑝𝑜𝑛𝑒𝑛𝑡𝑖)
2𝑁

𝑖=1
, the overall network connectivity. ECA is 

measured in units of area, i.e., hectare, or in the generic case in units of pixels. ECA_rel 
is the normalized or relative ECA with respect to 

ECA_max=∑ (𝑛𝑜𝑑𝑒 𝑎𝑟𝑒𝑎 𝑜𝑓𝑐𝑜𝑚𝑝𝑜𝑛𝑒𝑛𝑡𝑖)
𝑁

𝑖=1
, when all components are fully 

connected. When looking at landscape habitats, ECA_rel is also known as ARH 
(amount of reachable habitat) or PRH (percentage of reachable habitat). ECA_rel is 
equivalent to the Degree of network Connectivity (DOC) of the NW Components in the 
image.  

http://www.conefor.org/
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The information window below the main display shows the unique component 
identifier, the total area of the component, and the contribution of links. Saving the 
result will produce the following three files:  
a) <name>_nw.tif: same graphics as displayed in GTB 
b) <name>_nw_nwdata.tif: image with component IDs                        
c) <name>_nw.txt (only when saving the entire image): statistics for each component, 
total area, and contributed area of links, ECA, DOC. 
 

1.3.3.2 GTN Node/Link Importance 

 
This option will show the connectivity importance for each node and each link of the 
graph-theory network. The connectivity importance is calculated according to 
equation 4 in Saura (2009b) and having the following three contributions: 𝑑𝑃𝐶 =
𝑑𝑃𝐶𝑖𝑛𝑡𝑟𝑎 + 𝑑𝑃𝐶𝑓𝑙𝑢𝑥 + 𝑑𝑃𝐶𝑐𝑜𝑛𝑛𝑒𝑐𝑡𝑜𝑟, where the importance corresponds to the 
term dPCconnector only. The information window below the main display shows the 
node/link ID, and its absolute and relative connectivity importance. The importance 
of all Nodes is normalized such that the highest Node importance is assigned to 100%. 
The same normalization procedure is applied for the Links. After the normalization, 
each individual Link or Node will have a relative importance within [0, 100]%, with 
allows finding the most important Links and/or Nodes. 
With respect to the maximum importance of Nodes/Links we then assign a decreasing 
intensity of green color for Nodes: dark green (highest importance: 99-100%), medium 
green (importance 95-> 99%), light green (90->95%) and with a decreasing intensity of 
red for Links: dark red (highest importance: 99-100%), medium red (importance 95-> 
99%), light red (90->95%). Objects with a lower importance are color-coded with light 
purple color to mark Nodes (having a negative ID), while the black color denotes Links 
(having a positive ID to distinguish them from the Nodes).  
Saving the result will produce the following four files:  
a) <name>_cs.tif: same graphics as displayed in GTB 
b) <name>_cs_conn.tif: connectivity importance for each node and link. 
c) <name>_cs_ids.tif: unique identifier of each node and link where nodes have a 
negative sign to distinguish them from links. 
d) <name>_cs.txt (only when saving the entire image): statistics for each component, its 
nodes and links, area, and connectivity importance. 
 

1.3.3.3 MSPA ConeforInputs  

 
The option MSPA ConeforInputs will setup and save the two input files 
nodes_mspa_<input>.txt and links_mspa_<input>.txt for further analysis in Conefor (Saura, 
2009a). Use this option for detailed graph-theory analysis, which is beyond the 
network connectivity importance provided within GTB. When using this option MSPA 

CONEFORINPUTS the connectivity is defined via the MSPA-detected structural 
connectors (MSPA-Bridges). This is different to the option CONEFORINPUTS, where 
the connectivity is defined via the pairwise distance of image objects. 
  

http://www.conefor.org/
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1.3.4 Fragmentation 

 
Fragmentation can be seen as the spatial heterogeneity, or the spatial composition 
and arrangement of foreground objects in an image. It accounts for the number of 
objects and the distance between them, hence addressing foreground and 
background characteristics at the same time. Due to its holistic nature the description 
of fragmentation is rather complex and, in the case of landscapes, usually defined for 
a given species of interest and as such species-specific. Moreover, current 
fragmentation definitions are only descriptive and for this reason do not allow 
quantifying the degree or changes of fragmentation for a given image. In GTB, all 
fragmentation assessment schemes are designed to quantify fragmentation into the 
minimum-maximum range of [0 – 100]%. To further facilitate communication of the 
result the Divide Range panel below the viewport can be used to group the 
fragmentation values into the three categories small/medium/large. The GTB title bar 
provides additional summary information of the selected fragmentation assessment 
scheme.  
The aim in GTB is to describe fragmentation by using different concepts, each 
emphasizing a specific aspect of the very generic term fragmentation. Based on the 
nature of the selected approach, each concept will provide a focused result, which 
best matches the user-selected aspect of fragmentation. An additional benefit of 
quantifying the state of fragmentation in percent on a given map, all measures permit 
the comparison of the degree of fragmentation of different sites, the quantification of 
changes in fragmentation over time, and monitoring as well as measuring progress in 
planning programs and political directives. 
 

1.3.4.1 Fixed Observation Scale (FOS) 

 

This section provides methodologies to conduct a fragmentation analysis at a user-
selected specific Fixed Observation Scale (FOS). The user can choose between two 
moving window metrics and four reporting schemes. 
 
The two moving window metrics: FAD and FAC 
 
The concept of a moving window was introduced earlier and exemplified for FAD in 
FIGURE 16. A FOS-analysis can be conducted with measuring either the Foreground 
Area Density (FAD) or the Foreground Area Clustering (FAC) metric. FAD measures the 
proportion of foreground pixels with respect to the total number of pixels in the local 
neighborhood. FAC measures the proportion of foreground|foreground adjacencies 
with respect to the total number of adjacencies in the local neighborhood. FIGURE 25 
illustrates the difference between FAD and FAC at four example locations and using a 
3x3 neighborhood (umbrella) in the top panel, and for three amounts of foreground 
coverage in a 5x5 neighborhood in the bottom panel. Both metrics measure the 
degree of local connectivity, or its complement fragmentation. FAD is driven by the 
amount of foreground while FAC is driven by the local clustering or direct adjacency 
of foreground (for example forest pixels) in the local neighborhood (area under the 
umbrella) over each foreground pixel. Note the difference on the checkerboard. 
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Figure 25: Fragmentation metric FAD and FAC 

 

 
 
 
The four reporting schemes for FAD or FAC: 5class, 6class, APP_2class, APP_5class 
 
The resulting map shows the degree of connectivity, or fragmentation in percent 
within the neighborhood (under the umbrella) over each foreground pixel. This pixel-
level result can be reported as such or color-coded into several categories of 
connectivity/fragmentation to facilitate communication. Moreover, the per-pixel 
values of a given patch can be averaged into a single Average Per Patch-level value 
(APP), or into a single value across all foreground pixels for the entire map.  

Figure 26: Example for reporting connectivity/fragmentation using the default 5-class scheme 

  
 
FIGURE 26 shows the default 5-class reporting scheme where the full range of the 
metric FAD or FAC in [0, 100]% is divided into 5 reporting classes and their reference 
with respect to foreground cover, connectivity, and fragmentation. The map product 
is simply color-coded into these 5 categories to facilitate communication. The 
statistical summary provides the proportion of the total foreground area in each 
category and the average across all foreground pixels. For example, in class 4 the 
foreground cover within the neighborhood is dominant, which is equivalent to FAD or 
FAC being within the range [60, 90]%, the degree in connectivity is high, and the 
degree in fragmentation is low. The 6-class reporting scheme is similar but with a 
separate class 6, named Intact, where FAD/FAC = 100%, see also FIGURE 30. The 2-
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class reporting scheme (FIGURE 27) uses a threshold of 40% to divide the full range 
of connectivity into the two classes Separate and Continuous foreground cover: 

Figure 27: Example for reporting connectivity/fragmentation using the 2-class scheme 

 
 

Figure 28: FAD versus FAD-APP: forest density in the western part of Slovakia, using CORINE 2012 
data and an observation scale of 23x23 pixels ~ 529 ha.  
Left: FAD 6-class: per-pixel density and the default 6-class FAD color-table.  
Center: FAD-APP 2-class: per-patch average density and 2-class FAD-APP color-table.  
Right: same as center panel but applying the FAD-APP 5-class color-table. The center and right panel 
include average per patch (APP) density values for some selected patches. 

 
 
FIGURE 28 above shows the difference between the per-pixel FAD and the per-patch 
FAD-APP analysis. The moving window assessment scheme will assign lower density 
value to pixels along the patch boundary because the moving window area also 
includes background area outside of the patch boundary. This feature may be of 
interest to differentiate spatially intact areas from less intact areas inside larger 
patches. Users preferring to see a single and constant density value for each patch 
should select the option FAD-APP. Here, the density values of all pixels of a given patch 
are used to calculate the Average Per Patch (APP) FAD-value, which is then re-assigned 
to all pixel values of the given patch. In addition, the number of color-classes is 
reduced to either five, or two using a threshold of 40% in density to distinguish 
Separated (fragmented, dark-green) from Continuous (non-fragmented, light-green) 
foreground cover; a setup chosen by Forest Europe (Vogt 2019a) for the definition of 
the indicator 4.7 Forest Fragmentation; while FAO (Vogt 2019b), MAES (Maes 2020), 
EUROSTAT (Vogt 2022b), and EUFO (Vogt 2022c) have chosen the per-pixel FAD or FAC 
to measure forest fragmentation (see REFERENCES). The APP option provides actual 
FAD or FAC values in [0, 100]%, just averaged at patch level and color-coded in the 
user-selected number of fragmentation classes.  
More information is available in the Fragmentation Product Sheet. 
 
 

https://ies-ows.jrc.ec.europa.eu/gtb/GTB/psheets/GTB-Fragmentation-FADFOS.pdf
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In a dedicated popup window (FIGURE 29), the user can choose the FOS type 
reporting scheme, and define the observation scale by specifying the pixel resolution 
(in meters) and the side length (in pixels) of the square moving window in a GUI: 

Figure 29: FOS interface: select the reporting scheme and set the spatial resolution of the data and 
the moving window size to define a Fixed Observation Scale for the fragmentation analysis. 

 
 
The selected settings are then used to calculate the area of the moving window 
(observation scale), which is displayed in hectares and acres. The bottom panel of the 
GUI provides information on the pixel size retrieved via the gdalinfo command. Please 
note that this information is not automatically used for calculating the observation 
scale but displayed only as a guide for the user. The GDAL-reported pixel size may be 
in meters or degrees and can only be retrieved from properly formatted GeoTIFF 
headers. The image above shows a combination of pixel resolution and window size 
resulting in an observation scale of ~45 hectares (window side length = 27 pixels x 25m 
= 675m; window area = 675m x 675m = 455.625m2 = 45.5625 hectares). The user can 
choose settings from the drop-down menu or insert custom values, followed by the 
Enter key. After the definition of the analysis type and the user-selected observation 
scale, click on Accept to apply this scale for the fragmentation analysis.  
 
The input map for the FOS analysis must have the values 1 byte for background and 2 
byte for foreground. All background data pixels will fragment the foreground. 
Optionally, the input can have the values: 
0 byte – missing data. These pixels will show in white color in the output image. 
3 byte – specific background. These background pixels (e.g., water) will show in dark 
blue color in the output image. 
4 byte – non-fragmenting background. In contrast to all other background pixels, these 
background pixels will not have a fragmenting effect on the foreground. These pixels 
will show in light blue color in the output image.   

 
Because input data pixels with 4 byte do not have a fragmenting effect, changing 
background to non-fragmenting background will lead to a reduction of foreground 
fragmentation and consequently change the fragmentation statistics. 
Saving a FOS analysis will create a new directory with the naming convention <input 

name>_<FOS_type>_<windowsize> and the four files: 
a) <name>.tif: FOS output map 
b) <name>.txt: FOS summary statistics 
c) <name>.csv: FOS summary statistics in comma-separated value format for import into 
a spreadsheet application 
d) <name>.sav: FOS summary settings for change analysis 
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The resulting images have the following dedicated value assignments: 
1-100 byte: Foreground density (FAD) or clustering (FAC) value in percent 
101 byte: Background pixels (gray color) 
102 byte: Missing pixels (white color) 
105 byte: Specific background pixels (dark blue) 
106 byte: Non-fragmenting background pixels (light blue) 

 
Saving a zoomed area is disabled, or if needed use the Display Snapshot option from 
the Save Image menu but the statistics will always refer to the entire map area. When 
saving a FOS analysis all saved files refer to the entire extent of the original input map. 
 

 

 

1.3.4.2 Multiple Observation Scale 

 

This section provides methodologies conducting a fragmentation analysis for a series  
of five fixed observation scales with window/umbrella dimension 7x7, 13x13, 27x27, 
81x81, 243x243 pixels. These neighborhood areas were selected to span a wide range 
of scales representing an approximately geometric progression of window area with 
observation scale. An additional sixth map and related statistics show a summary 
across all five observation scales. 
 
➢ FAD: the Foreground Area Density  is measured at the five observation scales (FAD 

Multiscale) and masked for foreground (Riitters et al., 2002, 2012a, 2012b). The 
result is a set of five maps (one for each observation scale) showing the FAD value 
for each foreground pixel. The resulting maps list the FAD (density) values either 
per-pixel (FAD 6-class) or the Average-Per-Patch (FAD-APP) per patch. For visual 
clarity, the FAD values are displayed color-coded into the following fragmentation 
classes. 

 

Figure 30: Summary of FAD/FAD-APP fragmentation class thresholds, names, and color 
assignment. FAD is a per-pixel classifier while FAD-APP summarizes the average density value 
per patch. 
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The statistical summary (FIGURE 31) lists the proportion of foreground in each 
fragmentation class and for each of the 5 observation scales. The column mscale 
lists the MultiScale summary, which is built on a per-pixel basis across all 5 
observation scales.  The map legend and the aggregated results for the entire 
image are displayed as a cumulative bar chart. The observation scales 1, 2, 3, 4, 5 
correspond to the window lengths 7, 13, 27, 81, 243 pixels.  
 

Figure 31: Statistical summary table and bar-plot example for FAD 6-class multiscale analysis. 

 
 
 
The viewport image in GTB shows the multiscale FAD assessment: the average FAD 
value across all five observation scales, which is displayed color-coded into the 
user-selected fragmentation classes. When moving the mouse cursor into the 
viewport, the information panel below the viewport will display the cursor 
coordinates followed by the multi-scale FAD value and the sequence of FAD values 
across the five observation scales.  
 
The input map for the FAD multiscale analysis must have the same specifications 
as for the FOS analysis. 

 
The FAD multiscale analysis can be saved as a single multi-scale image when using 
the option Display Snapshot or KML. When using the option GeoTIFF or Generic 
the full result is saved into a new directory and the following files: 
a) <name>_FAD_{7/13/27/81/243}.tif: FAD-values at 5 observation scales 
b) <name>_FAD_barplot.png: FAD-bar chart summary 
c) <name>_FAD_mscale.txt: FAD summary statistics 
d) <name>_FAD_mscale.csv: FAD summary statistics in comma-separated value 

format for import into a spreadsheet application 
e) <name>_FAD_mscale.tif: FAD summary multi-scale image 
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The resulting images have the following dedicated value assignments: 
1-100 byte: Foreground density 
101 byte: Background pixels (gray color) 
102 byte: Missing pixels (white color) 
105 byte: Specific background pixels (dark blue) 
106 byte: Non-fragmenting background pixels (light blue) 
Saving a zoomed area is disabled, or if needed use the Display Snapshot option 
from the Save Image menu but the statistics will always refer to the entire map 
area. When saving a FAD multiscale analysis all saved files refer to the entire extent 
of the original input image. 
 
 
Note:  
1. The five observation scales are arbitrary; they were selected to span a wide 

range of scales (window area) and to approximate a geometric progression of 
window areas with scale. 

2. Please use the FOS scheme to conduct a single-scale FAD fragmentation 
analysis at a user-specified scale. 

3. The results displayed in the viewport could suggest that FAD may also be useful 
for labeling different morphological parts of the foreground patches (Riitters 
2005). However, such labeling is better accomplished by using the MSPA 
algorithm. 

 
 

➢ Dominance: Dominance is constructed by measuring the LANDSCAPE MOSAIC 
(LM) over five observation scales using a moving window analysis with square 
neighborhood area window length or kernel size ks = 7, 13, 27, 81, 243 pixels and 
applying foreground masking. The result is a set of five maps (one for each 
observation scale) showing the LM values for each foreground pixel. The LM values 
on each map are grouped into a summary LM that shows the same 19 mosaic 
classes as an across-scale analysis. The summary value for a given pixel is the result 
of applying the tri-polar LM-classification to the average values of each of the three 
variables in the tri-polar model.  

The input image for Dominance must be a Byte image with no more than 3 target 
classes and the assignment AND (1-Agriculture, 2-Natural, 3-Developed) plus an 
optional class for missing values (0 Byte). Dominance can be saved as a single 
multi-scale image when using the option Display Snapshot or KML. When using the 
option GeoTIFF or Generic the full result is saved into a directory having the 
following files: 

a) <name>_lm_ks.tif: LM-image at 5 observation scales 

b) <name>_lm_ks.csv/png/sav: LM-heatmaps at 5 observation scales 

c) <name>_lm_mscale.tif/csv/png/sav: LM-image and heatmaps across five 
observation scales 

d) heatmap_legend.png: explanatory chart, see FIGURE 21  
 



 47 

1.3.4.3 Legacy 

 
This section provides various fragmentation assessment schemes that have been used 
in the past. They are provided here for historic reasons and for the curious reader, 
who may be interested in alternative assessment schemes. 
 

Index 

 
The Fragmentation submenu Index provides methodologies resulting in a normalized 
fragmentation value (index) for the entire image. 

 
➢ Entropy: this option will calculate the ENTROPY of the entire image and the input 

map dimension must be at least 500 pixels in x- and y-direction. 
 

➢ Hypsometry: the Normalized Hypsometric Curve (NHMC, FIGURE 32) is the 
Hypsometric Curve (FIGURE 33) scaled by the maximum distance in the 
foreground and in the background. FIGURE 32 shows the NHMC for three images 
and the following three conditions: 

• Minimum fragmentation (black): NHMC of an image with maximum 
foreground aggregation: All foreground pixels accumulated to a circle.   

• Actual image (blue/green): NHMC of the actual image 

• Maximum fragmentation (red): NHMC of a checkerboard image of the 
same size as the actual image and with 50% coverage. This theoretical 
maximum condition for fragmentation is characterized by all foreground as 
well as all background pixels having 1 pixel and thus resulting in the step-
function outlined in red in FIGURE 32. 

 
Figure 32: Normalized Hypsometric Curve for minimum (black), maximum (red), and actual 
fragmentation state in the foreground (green) and in the background (blue). 
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For a given image, the degree of fragmentation (Kozak et al. (2018)) corresponds 
to the area covered between minimum fragmentation (black) and maximum 
fragmentation (red). In FIGURE 32, this area is highlighted in blue for the 
background and in green for the foreground. Accounting for the dual nature of 
fragmentation (foreground is fragmented by background and vice versa) the 
degree of fragmentation for a given image is defined by the weighted sum of 
fragmentation in the foreground and the background: 

            Frag (hypso) = (bg_area/100.0 * bg_frag) + (fg_area/100.0 * fg_frag) 
 
The so-defined fragmentation provides values in the range of [0, 100]%, 
accounting for and summarizing key fragmentation aspects: duality, perforations, 
amount, division, and dispersion of image objects.   
 

Map 

 
This section provides methodologies resulting in spatial distribution of normalized 
fragmentation values.  
 
➢ Entropy: in thermodynamics, Entropy describes the degree of disorder in a system. 

Transferring this concept into spatial geometry (raster images), we can use 
entropy as a descriptor for spatial fragmentation. Starting from the classical 
definition of entropy in information theory H = -∑ Pi * log(Pi) (Shannon, 1948) we 
define the discrete set of probabilities Pi as the probability that the difference 
between 2 adjacent pixels is equal to i and log is the base 2 logarithm. The original 
entropy definition has been implemented in many ways and it is important to 
distinguish the above definition of Pi from other commonly used indicators such 
as Shannon’s diversity index or the Evenness index (where Pi is the proportion of 
species) and variations of contagion indices (where Pi is the proportion of different 
type of pixel edges). In short, in Shannon’s original concept Pi refers to percentages 
of species classes in categorical maps, as defined in the species diversity literature. 
In contrast, here we investigate differences between cell values in all 8 directions 
(that is, the values of i), which is meaningful because raster images are continuous 
variables where their magnitude has meaning. While the entropy in the edge-type 
evenness is derived from the attribute adjacency table, the spatial entropy here is 
calculated on spatial tiles and assuming 8-connectivity for the foreground pixels.  
For a given amount of foreground area, an image with a single compact foreground 
object has minimum entropy while the entropy reaches its maximum value when 
the given area is split into the maximum number and dispersed equally over the 
entire image. Maximum entropy is thus found for a checkerboard distribution. 
These two boundary conditions define the possible range of fragmentation in the 
image. The spatial entropy is calculated by averaging calculations using box size 
tiles of 50 and 33 starting from the center of the image. This approach replaces the 
precise but much slower performing moving window computation. Finally, a 
smoothing filter is applied to return a spatial contiguous per pixel distribution. The 
result shows the normalized fragmentation as a function of spatial entropy.  
 

https://en.wikipedia.org/wiki/Diversity_index
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➢ Contagion: contagion describes the degree of clumpiness of image objects. With 
this definition, fragmentation can be defined as the complement of contagion (1 – 
contagion); an image region with high contagion is equivalent to having low 
fragmentation. The contagion of foreground objects is calculated via the moving 
window metric Contagion and the window size of 49 pixels, providing a statistically 
meaningful data sample. The result shows the normalized fragmentation as a 
function of spatial contagion.  
 
Both, Entropy and Contagion are local aggregation measures but with an 
important difference: while Contagion will consider the Foreground objects only, 
the Entropy based fragmentation assessment is based on the simultaneous 
evaluation of Foreground and Background together (duality). For example, an 
image with predominant Background cover (i.e., 95%) and a few isolated 
Foreground objects (5%) will result in high fragmentation values for Contagion. For 
Entropy, this image will have low fragmentation values because the dominant area 
coverage (Background) is only slightly fragmented by the Foreground. In fact, we 
will get the same low fragmentation value for Entropy when using the inverted 
image with 95% Foreground cover and 5% background; in this case, the dominant 
area coverage is now Foreground, which is only slightly fragmented by the 
Background. In short, Entropy derives Fragmentation for the interplay of Fore- and 
Background while Contagion will focus on the Foreground only.  
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1.3.5 Distance 

 
This menu provides several options for Distance analysis.  
When using GeoTIFF data the distance value in pixels is only meaningful for images 
having equal-area projection!   
 

1.3.5.1 Euclidean Distance 

 

This option calculates the approximate Euclidean Distance map for both, the 
background, and the foreground. If the Divide button below the viewport is not active, 
a click on the Intext button will trigger the display of two summary graphs:  
a) Distance histogram: including foreground and background specific information on 
average distance (adf/adb), total number of objects (fgo/bgo), and maximum distance 
found in the image. Here, Background data have a negative sign to distinguish them 
from foreground data. 
 b) The Hypsometric Curve: the normalized cumulative frequency of the Euclidean 
distance histogram: 

 
Figure 33: Hypsometric Curve for the Euclidean distance distribution in the foreground and in the 
background and related distance measures. 

 
 

When viewing the image distance distribution as a pseudo-elevation map the 
Hypsometric Curve summarizes the relief or contour lines in the foreground, the same 
process is known as bathymetry in the background. FIGURE 33 shows the normalized 
cumulative frequencies of Euclidean distances as well as the following related 
statistics for the background and the foreground: 
- Hypsometric Index (HI): adb/bg_max   or   adf/fg_max 
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- Hypsometric Area (HA): integral area under the curve 

- Average distance (adb/adf) 

- Maximum distance (bg_max/fg_max) 

- Number of objects (bg_obj/fg_obj) 

- Total area of objects (bg_area/fg_area) 

- Representative area (bg_Arep/fg_Arep)  

The Representative Area is calculated for a vicarious object of circular shape with a 
radius of adf/adb. In a similar way, a representative square object could be defined 

having the edge length √𝐴𝑟𝑒𝑝. As with the Average Distance (adf/adb), changes in 

the Representative Area are indicative for fragmentation processes. 
 

The GTB title bar shows adf/adb and the spatial distance distribution is displayed in 
the viewport. For each pixel, this map shows the shortest distance to the nearest 
foreground/ background boundary. The distance is provided in pixel units since the 
actual spatial pixel resolution is unknown. The color code is designed to mimic a 
pseudo elevation map: blue colors represent ocean (background), yellow/red/green 
colors represent land or mountains (foreground), and a value of zero is assigned to the 
coastline (intersection of foreground/background). Saving a Euclidean distance image 
will save the actual distance image as well as the histogram and the HMC bar plot 
images. As in any other image, the zoom function can be used to retrieve more 
detailed pixel information via the mouse cursor.  
More information can be found in the Distance Product Sheet. 
 

1.3.5.2 Influence Zones 

 

The influence zone is defined as the outside equal distance delimiter line (iso-
distances) separating selected foreground objects. The boundary of an influence zone 
is derived by applying a morphological watershed operator to the Euclidean distance 
map of the background area in the image. Considering the gray scale (8-connected 
Euclidean distance) image as a surface, each local minimum can then be thought of as 
the point to which water falling on the surrounding region drains. The boundaries of 
the watersheds lie on the tops of the ridges. Small objects in the original image can 
produce spurious minima in the gradients, which leads to over-segmentation. For this 
reason, the default minimum object size is set to 5,000 pixels. Omitted objects smaller 
than the minimum object size are displayed in pale blue color. Objects for which 
influence zones are calculated are displayed in alternating colors. Potential missing 
data is displayed in white and the influence zone boundaries (watershed lines) in black 
color. The information panel below the viewport allows setting buffer zones for both, 
foreground, and background. In summary, the influence zones provide a segmentation 
of the background and buffer zones can be added to define core areas as well as 
outreach zones of any size. 
 
Influence zones are driven by the following 3 parameters: 

https://ies-ows.jrc.ec.europa.eu/gtb/GTB/psheets/GTB-Distance-Euclidean.pdf
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1. Minimum area: influence zones are calculated for foreground objects larger or 
equal to the specified minimum area in pixels. The threshold of small objects to be 
excluded from the calculation can be set to any value via the MSPA parameter 2 
EdgeWidth drop-down menu. You can either select a pre-defined value or specify a 
custom value in the first entry of the drop-down menu. A new custom value will only 
be assigned after the Enter key has been pressed.   
 
2. FG Buffer zone: a non-zero value for the foreground buffer zone corresponds to 
the perimeter width of the foreground objects to be excluded from the calculation. 
Consequently, this parameter can be used to define core-foreground objects. In this 
case the title-bar will show, and the calculation will be conducted for foreground 
core objects having the minimum area specified via the MSPA parameter 2 
EdgeWidth. 
 
3. BG Buffer zone: a non-zero value for the background buffer zone will add a dark 
grey colored buffer zone of the specified width around, and if sufficiently large holes 
are present, inside the selected core or foreground objects. The boundary of the 
background buffer zone is depicted in pink color. Background buffer zones will 
terminate at the boundary of the influence zones. 
After changing any of the three influence zones parameters the Divide box under the 
viewport is changed to Off. Check the Divide box to On to apply any new influence 
zone settings. Clicking the Divide box switch to Off will reset both, the foreground and 
background settings to their default value of zero, omitting buffer zones and showing 
influence zones only. 
 
A minimum object area value of one (1) will calculate influence zones for all 
foreground objects. Since influence zones are defined to describe the outer region of 
objects, they are calculated for filled foreground objects. For this reason, objects 
insides holes of surrounding objects will have the same object ID and hence, the total 
number of objects when calculating influence zones may be smaller compared to the 
total number for object labeling. Saving an influence zone image will produce the 
following two files with the prefix <name>_influence_<Y>_<b1>_<b2>_<zoom>, 
where Y stands for the selected minimum object size in pixels, b1 and b2 stand for the 
selected foreground and background buffer zone width, respectively, and the suffix 
zoom will be added if a subregion of the image is saved: 
a) prefix.tif: same graphics as displayed in GTB 
b) prefix_ids.tif: image showing the unique identifiers of the objects, buffer zones and 
watersheds, etc. using negative values for specific data and positive values for the 
individual objects with the following notation: 
- 6: buffer zone 
- 5: buffer zone boundary 
- 4: missing data 
- 3: watershed 
- 2: omitted Foreground pixel 
- 1: hole in Foreground 
- 0: background 
1-x: unique object identifier 
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1.3.5.3 Proximity 

 

This option will measure the vicinity between neighboring objects. As with the 
Influence Zones, the objects of interest are defined with 8-connectivity and a 
minimum area, which can be set via the MSPA parameter 2 EdgeWidth. Objects 
smaller than the minimum size are displayed in light blue and the watershed line in 
black. When browsing with the mouse pointer through the image, the information 
panel below the viewport will list the component ID and the associated area in pixels, 
if we are in the background, or over an omitted foreground object.  

 
Placing the mouse pointer over the watershed line will list the x/y-coordinates of the 
watershed location and the following three measures (FIGURE 34 below illustrates a 
sample situation): 

 
1. Proximity: the proximity value is equivalent to the shortest distance, measured in 
pixels, needed to connect neighboring objects. Along the watershed line, this will be 
two objects. At watershed intersection points, the proximity value corresponds to the 
shortest distance needed to connect all neighboring objects.   

 
2. CAG: the Connected Area Gain (CAG) is a measure of how much area is gained when 
establishing a connection between disjoint components at a given location. In general, 
and when combining two objects with area a and b the combined reachable area 

becomes √(𝑎 + 𝑏)2 = √𝑎2 + 2𝑎𝑏 + 𝑏2. Here, the area gained through the 

establishment of the new connection is √2𝑎𝑏 when connecting 2 components, 

√2𝑎𝑏 + 2𝑎𝑐 + 2𝑏𝑐 when connecting 3 components, etc. For example, in FIGURE 34 
below the proximity between the two components with ID 4 and ID 3 is 18 pixels. The 
connected area gain at this location would be: 

𝐶𝐴𝐺 = √2𝑎𝑏 = √2 ∗ 5598 ∗ 16314 = 13515. 
 
3. CAG_rel [%]: the relative CAG [%] is defined as the ratio of CAG to the total area of 
all components. Larger percentage values imply that a larger amount of area will be 
connected and hence indicate a higher efficiency of a connection established at this 
given location.  
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Figure 34: Example showing Proximity and CAG (connected area gain) between two components. 

 
 
The left dropdown menu in the panel below the viewport, CoreZone, can be used to 
neglect branches by defining core zones of the objects. The dropdown menu on the 
right, Prox_max, can be used to define a maximum proximity value of interest. 
Proximity values equal to or smaller than Prox_max will be highlighted in yellow on 
the watershed line. The minimum proximity value is shown in red color and the total 
number of pixels having this minimum value is listed in the title bar description above 
the viewport. A mouse-click on the Divide button will reset the CoreZone and 
Prox_max fields to their default values of zero. The Proximity module can be used to 
examine the vicinity of neighboring objects while the CAG measures the (relative) 
importance for any proximity value. In combination, these tools may be useful to 
locate and evaluate restoration pathways of dissected landscape patches. 
 
Proximity statistics for the entire image may be obtained by clicking on MSPA-
parameter 4 Intext, providing the following three actions (FIGURE 35): 
 
Figure 35: Example showing Proximity and CAG statistic summaries for the entire image. Top: CAG 
range for each Proximity (connector length) value (to expand to the full proximity range click the blue 
cross in the bar plot – top right). Bottom left: Proximity frequency along the watershed. Bottom right: 
spreadsheet summary. 
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a) CAG histogram: a new graphic window plot (FIGURE 35 top left) showing the 
range of CAG values (minimum, median, maximum) encountered for each 
proximity value encountered along the watershed. The default proximity range is 
[0, prox_max]. Click the blue cross icon in the bar-plot image to display the full 
proximity range (FIGURE 35 top right). In addition, the maximum CAG found in 
the image and its x/y-location is printed out in red color in the bar plot image.  

b) Frequency histogram: a new graphic window showing the number of times a given 
proximity value was found along the watershed. The default proximity range is [0, 
prox_max]. Click the blue cross icon in the bar-plot image to display the full 
proximity range.  

c) Spreadsheet summary: a summary spreadsheet is written to disk providing 
comma separated information on location; proximity; CAG; number, ID, and area 
of objects for each watershed location. This csv-file can be imported into a 
spreadsheet application and then sorted to the property of interest; for example, 
to find the x/y-location providing the highest CAG or to list all CAG values and 
spatial locations for a given connector length (proximity). 

 
Saving the proximity analysis will produce the following five files with the prefix 
<name>_proximity_<Y>_<b1>_<b2>_<zoom>, where Y stands for the selected 
minimum object size in pixels, b1 and b2 stand for the selected values in the CoreZone 
and Prox_max fields, respectively, and the suffix zoom will be added if a subregion of 
the image is saved: 
a) prefix_CAG.tif: image showing CAG values along the watershed. 
b) prefix_viewport.tif: same graphics as displayed in GTB. 
c) prefix.csv: proximity/CAG statistic summary spreadsheet file (csv). 
d) prefix_ws.tif: image showing the proximity values on the watershed. 
e) prefix_ids.tif: image having positive values for the unique identifiers of the objects 
and negative values for specific data with the following notation: 
- 4: missing data 
- 3: watershed 
- 2: omitted Foreground pixel 
- 1: hole in Foreground 
  0: background 
1-x: unique object identifier  
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1.3.6 Restoration Planner 

 
The scope of the Restoration Planner is to provide tools tailored to reduce habitat 
fragmentation by increasing the area of reachable habitat and to provide answers to 
the following key questions: 
- What is the current restoration status of the existing network? 
- Where and how much has the restoration status changed over time? 
- How efficient is a specific restoration measure? 
- What is the most efficient restoration measure? 
- How can we simulate and evaluate various restoration measures? 
 
The tools are designed to measure coverage, connected extent and degree of 
coherence of an existing network of objects. Here, the generic term object refers to a 
landcover parcel, species habitat, or any other homogeneous area outline. A set of 
quantitative indicators is used to summarize the restoration status (TABLE 3) and/or 
evaluate the cost and efficiency of a restoration planning event (TABLE 4). The tabular 
summary statistics are derived from spatially explicit maps, allowing to detect 
hotspots of changes as well as locating positions where restoration planning is most 
efficient. The combination of spatially explicit maps and quantitative indicators has 
been designed as a framework to investigate planning scenarios in landscape planning 
as well as to provide concise and intuitive information to program managers, policy 
makers and the public. More details and examples are summarized in the Restoration 
Planner Product Sheet.  
All indicators are measured in pixels, which is only meaningful for images having 
equal-area projection!   
 

1.3.6.1 The restoration status indicators 

 
The Restoration Status indicators are based on the area of the network objects, 
attributing a higher importance to larger objects. The two key restoration status 
indicators, ECA (Saura et al. 2011) and Coherence are defined in FIGURE 36 and 
illustrated in FIGURE 37.  

Table 3: Summary of restoration status indicators.  

Acronym Name Description Unit  

ECA Equivalent 
Connected Area 

Area of a fictive single object providing the same  
amount of reachable area as the current set of objects 

pixels 

COH Coherence Degree of network coherence/connectedness [%] 

REST_POT Restoration 
Potential 

Network restoration potential (100% - COH) [%] 

RAC Reference Area 
Coverage 

Network area proportion with respect to map data area [%] 

CNOA Critical New 
Object Area 

Area of a single additional object resulting in the same 
network coherence as found in the original network. 

pixels 

https://ies-ows.jrc.ec.europa.eu/gtb/GTB/psheets/GTB-RestorationPlanner.pdf
https://ies-ows.jrc.ec.europa.eu/gtb/GTB/psheets/GTB-RestorationPlanner.pdf
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Figure 36: Definition of the two restoration status indicators ECA and Coherence 

 
 
 

Figure 37: Example for restoration status indicator calculation for a network with five objects. 

 
 
In principle, any kind of restoration planning will add new area to an existing network. 
Here, the key question is: which of the following is most efficient?  

Reconnect objects?     Add area to an existing object?     Add a new object? 
 
Because both, ECA and Coherence are driven by large object areas (Sum Of Squares – 
SSQ), it is evident that connecting large objects is most efficient, followed by adding 
area to preferably large objects. Adding a new disjoint object will typically increase 
fragmentation and consequently decrease network Coherence. The Critical New 
Object Area (CNOA) is the area of a new object, which is large enough to compensate 
the fragmentation effect and will result in the same network coherence as found in 
the original network. 

𝐶𝑁𝑂𝐴 = (2𝑏𝑐2)/(𝑏2 − 𝑐2)      with 𝑏 = 𝐸𝐶𝐴𝑚𝑎𝑥 and 𝑐 = 𝐸𝐶𝐴 
New object areas larger (smaller) than CNOA will result in coherence increase 
(decrease). Further details are beyond the scope of this manual but can be found in 
the Restoration Planner Product Sheet.  
 

https://ies-ows.jrc.ec.europa.eu/gtb/GTB/psheets/GTB-RestorationPlanner.pdf
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1.3.6.2 The restoration planning indicators 

 
The restoration planning indicators (TABLE 4) are designed to summarize and 
quantify the expense and efficiency of a given restoration measure. 
 

Table 4: Summary of restoration planning indicators. 

Acronym Name Description Unit  

RP Restore Pixels Length (in pixels) of a given restoration path [-] 

RESIST Resistance Difficulty to traverse a given pixel [3 – 100 (max)] [-] 

EXP Expense Effort to establish a restoration path (∑(RP*RESIST)) [-] 

EFFIC Efficiency Proportion: ECA gained per unit of Expense pixels 

AVDIST Remoteness Average distance of RP away from existing network pixels 

 
The effort to implement a given restoration measure is modelled via the narrative 
resistance, defined as the relative difficulty to traverse a given location. For a raster 
image, each pixel is assigned to a specific resistance value of either: 
- 0: pixel that can never be traversed (blocking = infinite resistance) 
- 2: pixels of foreground object, having minimum resistance 
- [3, 100] background pixel, having a larger resistance than foreground of at least 3 
and maximum 100.   
 
Because movement outside of foreground (FG) is more difficult, the background (BG) 
resistance must always be higher than the foreground resistance. BG-resistance starts 
at 3 to maintain compatibility and input data notation with all other GTB routines 
where FG is assigned a value of 2 byte. BG-resistance values are not simply sequential 
but can cover the entire range from minimum to maximum resistance [3, 100]. For 
example, assume you are interested in woodland species and you have 5 landcovers 
with different perceived resistances: woodland, natural grassland, intensive grassland, 
cropland, water: woodland equals target habitat (resistance=2), natural grassland is 
favorable to woodland species (Resistance=5), intensive grassland is 3 times more 
resistant than natural grassland (Resistance=15), cropland is 10 times more resistant 
than natural grassland (Resistance=50), water bodies cannot be traversed by the 
woodland species (Resistance = 0). Assigning different relative resistance values will 
result in different restoration expense, pathways, etc.  
 

Setting the BG-resistance values is crucial, requiring a good deal of 
thought and rationale! 

 
The generic narrative resistance allows the user to finetune the image to specific 
application setups: BG-pixels can be assigned to have a fixed resistance, or a variable 
landcover-specific resistance, or a resistance that is proportional to the distance away 
from FG-objects (i.e., for birds or flying insects). Other custom resistance assignments 
could be to assign country roads a lower resistance than motorways, or privately-
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owned farmland a higher resistance than public farmland, or forest in protected areas 
a lower resistance than state-owned forest. You could block areas from being 
traversed by assigning them a resistance value of zero, or favor areas to be used for 
restoration by assigning them a low resistance value. 
Once an application-specific BG-resistance is assigned, one can then select a start and 
target object that should be reconnected, exemplified in FIGURE 38. 
 

Figure 38: Sketch of restoration path evaluation between start and target object. 

 
 
FIGURE 38 shows an example comparing three potential restoration pathways (a, b, 
c) between a start and a target object. Along the individual path segments the number 
of restoration pixels is shown in red color and the respective BG-resistance in gray 
color. The right part of the figure illustrates the calculation of the restoration planning 
indicators concluding in restoration path a being the most efficient of the three 
options.  
Restoration pathways may be inserted manually, or the optimum pathway can be 
automatically detected using the Generalized Geodesic Distance (GGEO) function 
(Soille 1994). GGEO calculates the fastest travel time (minimum of accumulated 
Background-resistance = Least Cost Path) between two objects, trying to take 
advantage of steppingstones along the pathway to reduce travel time and to minimize 
restoration expense. An increase in BG-resistance enforces stronger optimization by 
including more intermediate objects, resulting in less expense and a higher coherence 
gain. 
 
The restoration pixels of a given path are located at a certain distance away from 
existing FG-objects. 𝐴𝑉𝐷𝐼𝑆𝑇𝑅𝑃 (FIGURE 39) provides an indication of the average 
“remoteness” of the restoration pixels. When finding an optimum path via GGEO, 
𝐴𝑉𝐷𝐼𝑆𝑇𝑅𝑃 will be smaller due to the inclusion of steppingstones, hence a low value of 
𝐴𝑉𝐷𝐼𝑆𝑇𝑅𝑃 will be indicative for an efficient restoration effort. 
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Figure 39: Illustration of AVDISTRP, indicating the average remoteness of a given restoration pathway. 

 
 
The Restoration Planner provides various modules for restoration planning and 
assessment grouped into the following two sections: Setup Tools and Assessment. 
 
 

1.3.6.3 Setup Tools 

 
The submenu Setup Tools provides interactive methods and guided help to setup an 
application-specific resistance map and/or to define the input map for a travel time 
analysis.  
 
➢ Fixed BG-Resistance: from a new popup-window (FIGURE 40), select a resistance 

value from a dropdown menu that will be assigned to all BG-pixels of the current 
image. Missing data (pixel value = 0) are assigned a resistance value of zero 
(blocking).  

Figure 40: Example to assign a fixed BG-resistance for all BG-pixels. 

 
 
 

➢ Landcover → Resistance: a new popup-window (FIGURE 41, similar to the 
RECODE option) provides a recoding table showing the existing landcover classes 
in the right column which should be assigned to landcover class specific resistance 
values [0, 2, 3-100] in the left column. The Save button may be used to save a 
custom resistance mapping table to disk, which can be restored via the Restore 
button in a future session. 
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Figure 41: Example to assign a landcover specific resistance value. 

 
 
 
 

➢ Distance → Resistance: after calculating the Euclidean Distance in the Background, 
the distance (measured in pixels) away from FG-objects is assigned to the BG-pixels 
(FIGURE 42) starting with a resistance value of 3 and constrained to a maximum 
resistance value of 100. The resistance values are shown in the information panel 
below the viewport for the current location of the mouse pointer in the image. 

 

Figure 42: Example to assign a distance-based resistance map. 
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➢ Pixel → Resistance: in a new popup-window (FIGURE 43), insert the x- and y-
coordinate and the new resistance value of your choice. Please press the Enter key 
in each field to validate your settings. 

Figure 43: Example to assign a pixel-based resistance value. 

 
 

   
➢ Line → Resistance: this option allows to interactively draw a custom path with a 

custom resistance into the image. First, click on MSPA-Parameter 1 FGConn to 
activate the process. Next, draw a straight line (left mouse button) or a freehand 
line (right mouse button) while keeping the mouse button pressed. Release the 
mouse button to finish the drawing process. In the final popup-window (FIGURE 

44), select the resistance value and linewidth that should be assigned to the line 
drawn. 

Figure 44: Example of Line → Resistance interface: insert a straight line of width 5 pixels (i.e., a 
motorway, blocking resistance – left panel); insert a freehand line of width 3 pixels (i.e., a 
hedge row, FG-object – right panel). 

 
 
 

➢ Region Of Interest → Resistance: this option allows to interactively draw a custom 
area with a custom resistance into the image. First, click on MSPA-Parameter 1 
FGConn to activate the process, opening the entire image in a new popup-window. 
Next, use the appropriate menu button (FIGURE 45, top panel) to add a new 
Region Of Interest (ROI), which can be rectangular, oval, freehand, or a polygon. A 
second small popup-window will provide an overview of all added ROIs. Please 
note that area and length readings within the ROI window are approximate only. 
All added ROIs are shown in cyan color, while the currently selected ROI is marked 
with red color. The Pointer and Hand tool from the menu bar can be used to shift 
or warp a selected ROI. 
 
The ROI interface will show the current GTB viewport image in full resolution. If 
the image is larger than the screen display window, scroll bars in x- and y-
dimension are added automatically. If the current GTB viewport image is displayed 
in zoom mode, the ROI interface will show the zoomed sub-image extent in full 
resolution, which should facilitate adding custom ROIs at specific locations.  
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Due to image rescaling, the area/length measures displayed within the ROI 
interface are approximate or indicative only. Correct area readings may be 
retrieved on the final image using ACCOUNTING or other GTB assessment tools. 
 
The ROI interface can also be used to select an existing irregular shaped object 
(FIGURE 45, bottom panel), for example to assign it to a new resistance value: 
start with placing a small ROI inside the target object. With the mouse pointer on 
the small ROI, make a right-click and choose Grow Region, which will automatically 
select the perimeter of the irregular shaped object. Select the Properties option to 
finetune the region growing settings. Once all ROIs are defined, simply exit the ROI 
window, and assign the desired resistance value to all ROIs in the final popup 
window. 
 

Figure 45: The ROI interface to define custom regions (top), example to select irregular shaped 
objects through region growing (bottom left and center), and final ROI resistance assignment 
window (bottom – right).  

 

 
 
 

➢ Isochrone Map Marker Image: this option provides guided steps to setup a marker 
image, specifying the start object (mandatory) and the optional target object and 
missing data (FIGURE 46). The marker image is a single-band image of datatype 
Byte with the same dimensions as the resistance map and having the following 
values: 



 64 

0b: background  
1b: start object A (either a single pixel or the area of an object) 
2b: target object B (optional, only needed for Isochrone Map AB) 
3b: no or missing data, or areas that should be neglected (optional) 
 
The start/target objects A and B must be unique and must not intersect. The final 
marker image is written to disk and can then be applied to a suitable resistance 
map for travel time analysis using the Generalized Geodesic Distance function 
(GGEO, Soille 1994), see Isochrone Map A or Isochrone Map AB below.  

Figure 46: Three step setup to define a marker image for travel time analysis. 

 
 
 
The Setup Tools allow to simulate any type of landcover change or spatial  
restoration scenario. Once defined, the new setup can then be quantitatively 
evaluated via the Assessment menu to retrieve either, a new status summary and/or 
to quantify the efficiency of a simulated restoration measure. 
 
 

1.3.6.4 Assessment 

 
The submenu Assessment provides the following interactive methods and guided help 
to conduct restoration status-, change-, planning- and travel time analysis.  
 
➢ Status Summary: this option will calculate and summarize the key restoration 

status descriptors of the network (FIGURE 47): area, coverage (RAC), # of network 
objects, area of largest object, average object/patch size (APS), CNOA, reachable 
area (ECA), degree of coherence (COH) and its complement restoration potential 
(REST_POT).  
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Figure 47: Example of restoration status summary assessment. 

 
 
Please use the RESTORATION STATUS batch module to derive a tabular 
restoration status summary for a series of input files. 
The main purpose of Status Summary is to get a quick overview on the current 
restoration status of a given network. 

 
 
➢ Change Summary: this option will calculate and summarize the key restoration 

planning descriptors (FIGURE 48), which are derived by building the difference 
between the original network and the modified network including the restoration 
features. The Restoration Change summary requires that both images must have 
identical geospatial coverage. This option is applicable to any kind of restoration 
scenario, such as a single new pathway or any custom setup via Setup Tools. The 
result permits to quantify restoration effort and benefit expressed via the number 
of restore pixels, remoteness, expense, efficiency, change in ECA/COH. 

Figure 48: Example of restoration change summary assessment. 

 
The main purpose of Change Summary is to quantify cost, efficiency, and impact 
of a restoration event on the restoration status of the network. 

 
 
➢ Add Custom Path: this option allows to interactively draw a custom, 1-pixel wide 

restoration pathway into a restoration-compliant resistance image (0: missing, 2: 
FG, 3→100: BG). First, click on MSPA-Parameter 1 FGConn to activate the process. 
Next, draw a straight line (left mouse button) or a freehand line (right mouse 
button) while keeping the mouse button pressed. Release the mouse button to 
finish the drawing process. A new popup window lists key indicators of the 
restoration path, highlighted as a red line in the viewport. Start-, target- as well as 
any intermediate encountered network objects are shown in beige color (FIGURE 

49). Tabular summary statistics are saved to disk when saving the image. Click on 
MSPA-Parameter 1 FGConn to reset the analysis for additional testing. FIGURE 50 

shows, on a slightly zoomed subregion, a straight-line reconnecting pathway 
between the same two start/target object as shown in FIGURE 49. Please note 
the differences in restoration planning indicators: while the freehand line path 
entails more restore pixels, the gain in coherence and the efficiency is higher 
compared to the straight line due to the inclusion of intermediate steppingstones, 
which will reconnect more habitat area. The beneficial effect of reconnecting 
intermediate habitat is even more pronounced when detecting the optimum 
reconnecting pathway, see next section and FIGURE 51.  
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Figure 49: Example for Freehand Custom Path restoration assessment. 

 
 

Figure 50: Example for Straight Line Custom Path restoration assessment.   

 
The main purpose of Add Custom Path is to assess the impact of an already defined 
restoration pathway or to quickly simulate and evaluate various options of 
restoration pathways. 
 
 

➢ Find Optimum Path: this option will calculate and display the optimum restoration 
pathway between two user-selected objects on a restoration-compliant resistance 
image (0: missing, 2: FG, 3→100: BG). First, click on MSPA-Parameter 1 FGConn to 
activate the process. Follow the on-screen instructions to define the start object 
and the target object, then click on MSPA-Parameter 1 FGConn again to start the 
detection. The optimum path (minimum travel time and expense) depends on the 
BG-resistance. It is calculated via GGEO, which tries to take advantage of 
steppingstones along the pathway to reduce travel time and to minimize 
restoration expense (FIGURE 51). An increase in BG-resistance enforces stronger 
optimization by including more intermediate objects, resulting in less expense and 
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a higher coherence gain. The left panel of FIGURE 51 shows the setup instructions, 
the center panel the optimum path between the start object (dark-blue) and the 
target object (light blue) with restore pixels highlighted in red color, and the right 
panel the travel time map with the least cost path outlined in grey color. The 
optimum path may include alternative, parallel pathways and/or bifurcations in 
the background having the same isochrone value. While alternative pathways are 
important for planning restoration pathways, these features may lead to an 
increased number of restore pixels and expense resulting in a decrease in 
efficiency. This implies, that the actual efficiency will be higher, if alternative 
pathways are neglected.  
Please note the difference in parameters, esp. efficiency in FIGURE 51 compared 
to FIGURE 49 and FIGURE 50 connecting the same two objects. In this example 
with a constant BG-resistance of 30%, the optimum path takes advantage of 
intermediate objects. To establish this path, only 65 restore pixels are needed with 
an expense of 65*30 = 1950, while coherence will increase by 11%.   

Figure 51: Example for Optimum Path restoration assessment. 

 
The main purpose of Find Optimum Path is to detect the optimum restoration 
pathway between two given objects. The drawback is slow processing time. 

 
 
 
➢ Show Optimum Big 5: this option will calculate the pairwise optimum pathway 

between the five largest objects on a restoration-compliant resistance image (0: 
missing, 2: FG, 3→100: BG). The result shows the restoration pixels in red between 
the five largest objects color-coded in decreasing size from the largest object in 
blue, cyan, green, yellow, and brown. The image is accompanied by a summary 
table (FIGURE 52) listing the size of the objects and the related restoration 
planning indicators. This table can then be sorted for the topic of interest. In this 
example, the most efficient restoration pathway (EFFIC=217) is found for 
connecting the largest object with the fifth-largest object (1 ↔ 5), requiring 2 
restore pixels only to achieve the highest efficiency (ratio of ΔECA/EXPENSE). If the 
focus is on coherence increase, then the connection between the second and 
fourth biggest component (2 ↔ 4) should be considered.  



 68 

Saving the result will create a new directory with the aggregated map and 
summary table as well as 10 individual maps of restoration and travel time 
pathways between each of the 5 largest objects. 

Figure 52: Example for Optimum Big 5 restoration assessment.  

 
The main purpose of Optimum Big 5 is to detect the optimum restoration pathway 
within the entire image. The drawback is very slow processing time. 

 
 

➢ Isochrone Map A: this option will calculate and display the travel time map starting 
from object A. The input map must be a restoration-compliant resistance image 
(0: missing, 2: FG, 3→100: BG). The MARKER IMAGE should be setup via the 
Isochrone Map Marker Image from the Setup Tools menu. 
The main purpose of Isochrone Map A is to display the travel time distance from a 
selected object, which might be of interest for restoration planning starting from 
that object. The drawback is slow processing time. 
 
 

➢ Isochrone Map AB: this option will calculate a travel time map starting from object 
A and a second one starting from object B, which are then combined into the final 
travel time map AB. The input map must be a restoration-compliant resistance 
image (0: missing, 2: FG, 3→100: BG). The MARKER IMAGE should be setup via 
the Isochrone Map Marker Image from the Setup Tools menu. 
Pixels having the minimum value of this map correspond to the shortest travel 
time and their skeleton is the Least Cost Path between start object A and target 
object B. The title bar shows the minimum and maximum travel time values 
encountered in the image. Travel time inside a start/target object is set to zero. 
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The division panel below the viewport can be used to group the normalized travel 
time surface into the ranges small/medium/large using either pre-defined or 
custom threshold values in the respective drop-down menu. This option may be 
of interest to highlight travel time corridors between A and B with a slightly 
increased minimum travel time (i.e., 1.1 x least cost) to visualize and/or investigate 
potential alternative connecting pathways. Values in [0, 100] show the normalized 
travel time while the following values are reserved for specific assignments: 
101: start/target object A/B 
102: missing data 
103: Least Cost Path 
104: pixels that cannot be reached from the start/target object 
 
The main purpose of Isochrone Map AB is to display the travel time surface 
between two selected objects. This information may guide finding suitable 
restoration pathways or evaluating additional restoration expense when deviating 
from the optimum pathway. The drawback is slow processing time. 
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1.4. The Help pull-down menu  

 
The Help pull-down menu offers the following options: 
 
➢ GTB Documentation 

➢ GTB Online 

➢ Related Resources 

➢ Bug Report 

➢ About GTB 

 

 

 

 

1.4.1 GTB Documentation 

 
➢ GTB Manual: this option will open the GTB Manual in a separate window. The 

manual provides general information on the graphical elements and the nature 
and functionality of the various GTB menus and options. 
 

➢ MSPA Guide: this option will open the MSPA Guide in a separate window. The 
guide contains important, detailed information on the input data requirements for 
the processing of MSPA, the MSPA parameters, the resulting MSPA image output, 
and on the use of the MSPA-standalone version. Please read this document 
carefully. It contains all MSPA related information, GTB is only a graphical 
interface, designed to facilitate MSPA processing. 

 
➢ GSC Guide: this option will open the GraySpatCon Guide in a separate window. 

The guide contains important, detailed information on the input data 
requirements for GSC processing, the GSC parameters, the resulting GSC image 
output, and on the use of the GSC-standalone version. Please read this document 
carefully. It contains all GSC related information, GTB is only a graphical interface, 
designed to facilitate GSC processing. 

 
➢ Changelog: this option displays recent changes and feature additions of the 

current GTB version. 
 

➢ EULA: this option will display the terms of the End User License Agreement (EULA). 
Using GTB requires acceptance of these terms. 

 
 
 
 
 
 

https://ies-ows.jrc.ec.europa.eu/gtb/GTB/GuidosToolbox_Manual.pdf
https://ies-ows.jrc.ec.europa.eu/gtb/GTB/MSPA_Guide.pdf
https://github.com/ec-jrc/GWB/blob/main/tools/external_sources/GRAYSPATCON_Guide.pdf
https://ies-ows.jrc.ec.europa.eu/gtb/GTB/changelog.txt
https://ies-ows.jrc.ec.europa.eu/gtb/GTB/EULA_GTB.pdf
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1.4.2 GTB Online 

 
➢ GTB News: this option displays current ongoing activities and upcoming changes 

to be included in a future version or revision of GTB. 
 

➢ GTB Homepage: this option will open the GTB homepage in a web browser 
providing current information on the GTB software. 
 

➢ Check for Updates: use this option to check for & install GTB upgrades: 
o Program release: includes major changes within the libraries of the IDL 

programing framework requiring a new installation of GTB.  
o Revision release: a small patch, which will either fix issues found in the 

current program release and/or add new features. A revision release can 
be installed automatically into the existing installation. 
 

➢ GTB Product Sheets: use this option to open the GTB homepage at the section 
Product Sheets providing links to pdf-files having further documentation, 
explanation and application examples of dedicated GTB products. 
 

➢ GWS (GTB Workshop): use this option to install or upgrade the GTB Workshop 
material. This material contains presentations with many details on the 
motivation, design, functioning, and application fields of the different 
methodologies available in GTB. It is complemented by key reference publications, 
as well as sample data sets and instructions to illustrate using these tools. This 
package is used during the GTB training courses, but it can also be easily followed 
by the interested GTB user. The workshop material can be installed automatically 
into an existing installation. 

 
➢ GWB (GTB Workbench): this option will open the GWB homepage in a web 

browser. GWB provides the most popular GTB analysis modules as command-line 
modules on 64bit Linux workstations and servers. Command-line instructions, 
valid for any GWB installation and exemplified with the two included sample 
images, are detailed on the GWB homepage. 

 
 
 
 

1.4.3 Related Resources 

 
➢ GIS Introduction: an introduction into the Geographical Information System (GIS) 

provided by members of the QGIS project. 
 

➢ GDAL: a translator library for raster and vector geospatial data formats providing 
a variety of useful command line utilities for data translation and processing. 
 

https://forest.jrc.ec.europa.eu/en/activities/lpa/gtb/#Productsheets
https://forest.jrc.ec.europa.eu/en/activities/lpa/gtb-workshops/
https://forest.jrc.ec.europa.eu/en/activities/lpa/gwb/
https://docs.qgis.org/3.16/en/docs/gentle_gis_introduction/index.html
https://qgis.org/en/site/
https://gdal.org/
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➢ CCRS Tutorial: an introduction into the fundamentals of Remote Sensing provided 
by the Canada Centre for Mapping and Earth Observation. 
 

➢ OpenForis: OpenForis is a set of free and open-source software tools that 
facilitates flexible and efficient data collection, analysis, and reporting. 

 
➢ SEPAL: the FAO cloud computing platform provides a variety of tools for geospatial 

analysis in a browser-based online portal. SEPAL includes the GuidosToolbox 
Workbench (GWB), providing easy access to the most popular GTB analysis 
modules, via either the command-line interface or a GUI. 

 
➢ EUFO: the EU Observatory on Deforestation and Forest Degradation, exemplifying 

forest attribute layers (Fragmentation, Accounting, Pattern) derived with GWB.  
 

➢ TreeAtlas: a link to the free European Atlas of Forest Tree Species. 
 

➢ IMPACT Toolbox: this software collection offers a combination of remote sensing 
techniques, photo interpretation, and processing technologies in a portable and 
stand-alone GIS environment allowing users to accomplish all necessary pre-
processing steps to produce a landcover map from Earth observation data.  
 

➢ Conefor: this software permits quantifying the importance of habitat patches and 
links for landscape connectivity. In GTB, you may use CONEFORINPUTS or MSPA 

CONEFORINPUTS to setup input files for further graph-theory analysis in Conefor.  
 

 

1.4.4 Bug Report 

 
This option will setup a text file for bug reporting, including date and program version, 
details on the currently loaded image, operating system summary and instructions to 
complete the report. If you find a problem, please follow the instructions, and email 
the finalized report to the developer. Please provide precise and concise information 
allowing to duplicate your issue, which will facilitate detecting and fixing the problem 
in a future update.  
 
 

1.4.5 About GTB 

 
This option provides information on the currently installed program/revision version 
of GTB, homepage and contact information, the operating system dependent 
additional software, and the maximum image dimensions for various processing 
routines supported in GTB. On Linux and macOS the maximum supported image 
dimension for MSPA is recalculated dynamically accounting for the actual amount of 
available free RAM in the operating system. 
  

https://www.nrcan.gc.ca/maps-tools-publications/satellite-imagery-air-photos/tutorial-fundamentals-remote-sensing/9309
https://www.openforis.org/
https://sepal.io/
https://forest.jrc.ec.europa.eu/en/activities/lpa/gwb/
https://gwbdoc.readthedocs.io/en/latest/
https://docs.sepal.io/en/latest/modules/dwn/gwb.html
https://forest-observatory.ec.europa.eu/
https://forest-observatory.ec.europa.eu/forest/gfa
https://forest.jrc.ec.europa.eu/european-atlas/
https://forobs.jrc.ec.europa.eu/products/software/
http://www.conefor.org/
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2. The Image/Display Attributes window (top left panel) 
 
This panel allows changing the image and display attributes of the image shown in the 
viewport in the right panel.   
 

 

The left side provides: 

- Normalized: display the image values using either their apparent values (default) or 
normalizing them into the range [0, 100].  
 

- Autostretch: this switch will scale the present image values into [min, max].  This 
feature can be used to visualize images with small contrast range when using  s 
spanning the entire range of [0, 255] byte.  

 
- Original Image: selecting this button will restore the initially loaded image. 
 
- Image Info: a separate window will display details of the currently loaded image, 
such as data type, number of bands, unique pixel values, and, if a GeoTIFF image was 
loaded, the geoheader information including projection name and EPSG-code. 
 
 
 
The right side provides: 
 
- Select Colortable: a series of predefined color tables and the option to setup a user-
defined color table adjustable via a dedicated window interface. The option 
Save/Restore allows for saving or restoring any GTB-generated color table. 
 
- Zoom Mode/Factor: these settings are used to specify a rectangular Region Of 
Interest (ROI), a sub region of the image: prior to the definition of the ROI, a zoom 
factor in the range of [1, 10] should be selected from the Factor drop-down menu. 
Next, a rectangular ROI is defined by holding down the left mouse button and dragging 
the mouse inside the graphic display. The selected region is outlined in green color 
and constantly updated until the mouse button is released. The selected zoom factor 
is then applied to the selected area and displayed in the viewport.  The Zoom Mode 
button changes to Quit Zoom, providing the option to return to the display showing 
the entire image extent. 
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3. The MSPA window (bottom left panel) 
 
This window is divided into the following two segments: 
 

3.1. MSPA Settings 

 
This window allows changing the settings of the four MSPA parameters (more details 
can be found in Help → GTB Documentation → MSPA Guide): 
 
1. FGConn: the default setting for the connectivity of the foreground pixels is 8-

connectivity (cardinal and diagonal directions) but may also be constrained to 4-
connectivity (cardinal directions only). 
     

2. EdgeWidth: the MSPA analysis scale driving the distance of the non-Core boundary 
classes (default: 1); the selected value is equivalent to the resulting boundary 
width in pixels. The x-entry in the drop-down menu can be used to insert a custom 
value within [0, 100]. A new custom value will only be assigned after the Enter key 
has been pressed.  
 

3. Transition: Transition pixels are those pixels of an Edge or a Perforation where the 
Core area intersects with a Loop or a Bridge. The default value (1: checkmark set) 
is to show transition pixels as Loop or Bridge pixels connecting to the Core area. 
However, doing so will interrupt the visual integrity of a closed Edge or Perforation 
perimeter. The closed perimeter display can be maintained by switching transition 
to off (0: checkmark unset). Please note that when transition is off, short Bridges 
of 2 pixels will not be visible since they are hidden under the Edge/Perforation 
pixels.  
Changing the Transition setting will change the visual appearance only but not the 
actual pixel values or statistics of the MSPA image! 
 

4. Intext: this parameter allows distinguishing internal from external background, 
where internal background is defined as being surrounded by blue Perforation 
pixels. The default is to enable this distinction, which will add a second layer of 
classes to the seven basic classes.  All classes, except for Perforation, which by 
default is always internal (105 byte), can then appear in internal or external 
background.  
Setting Intext=1 is needed to retrieve information on Openings in the Foreground. 
Please read the Help → GTB Documentation → MSPA Guide for further details. 

 
The 4-parameter fields are also used for non-MSPA purposes (MARKER IMAGE, 
RECODE LINE, RESTORATION PLANNER and DISTANCE analysis), please consult the 
respective section for further information. 
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3.2. MSPA Statistics 

 
The MSPA analysis requires a (pseudo-) binary input image. In general, the rectangular 
image area is composed of the following two parts: 
1) Data area (required): pixels with information and assigned to be either background 
or foreground. 
2) Missing area (optional): pixels without information. 
 
In the left image below, the data-area corresponds to pixels where information is 
available (the rectangular area composed of grey-scale pixels). The no-data area, 
where pixel information is not available, are the cloud pixels (white pixels at the 
bottom left of the data area) and the boundary segments (black) between the image 
boundaries and the grey data area. Please note that a particular landcover type could 
be defined as ‘Missing’ to exclude it from the MSPA analysis. 

Figure 53: Left: the rectangular image area is composed of data and no-data area.  
Right: example of entries in the MSPA statistics window.  

 

We have: Image = Data + Missing = (Foreground + Background) + Missing 
The MSPA statistics window shows simple statistics of the seven basic MSPA 
Foreground classes plus Missing, Background and Openings: 
Left column: shows the percentage = number of class pixels per foreground area and 
per data area. 
Right column: shows its frequency = number of unique objects of the given class and, 
where applicable, the area = number of background pixels covered.  
In the example above and exemplified for the class ISLET we find: 
- 3.26% of the Foreground area are Islet pixels 
- 1.40% of the Data area (= Foreground + Background) are Islet pixels 
- 2429: there are 2,429 Islets (regardless of their individual size) in this image. 
 
Similarly, for the class PERFORATION the statistics show that the image has a total of 
423 perforations, and all perforation pixels together make up 2.17% of the Foreground 
area, or 0.93% of the Data area (foreground area + background area). The total 

https://ies-ows.jrc.ec.europa.eu/gtb/GTB/MSPA_Guide.pdf
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Background area enclosed by Perforation pixels (Core-Openings) amounts to 5,927 
pixels.  
Important: changing the setting for Transition only changes the display color of the 
Transition pixels, it has no impact on the actual pixel values. Regardless of the actual 
Transition setting, the statistics in GTB/GWB are always calculated for closed 
boundaries (Transition=0) to provide consistent results for the parameter Porosity, 
see below or page 6 of the Morphology product sheet. In this way, page 6 of the MSPA 
Guide, the pixels of class 5b) Loop in Edge and 6b) Bridge in Edge converge in the 
statistic of class 4) Edge, and the pixels of classes 5c) Loop in Perforation and 6c) Bridge 
in Perforation converge in the statistics of class 3) Perforation.  
 
Openings: a given foreground cover may contain openings, which can be divided into 
Core-openings (dark-gray, 100 byte; completely inside Core and surrounded by blue 
Perforation pixels) and Border-openings (medium-gray, 220 byte; next to foreground 
boundaries and not completely inside Core). Statistics for both type of openings are 
displayed in the MSPA statistics window and opening pixels are assigned with the 
values 100/220 byte, if Internal = 1. If Internal = 0 no distinction is made between 
regular background and Openings. Finally, the integral Foregound (iFG) is defined as 
the sum of foreground + all openings. There are 2,291 openings in the Foreground 
area with a total area of 57116 pixels. 717 of the 2,291 openings are Core-Openings 
within the Core area of the forest covering a total area of 5927 pixels (area inside of 
Perforations). The remaining 1574 openings are Border-Openings (see bottom panel 
in MSPA statistics in FIGURE 53) located along the outside forest boundary (Edge) and 
covering a total area of 51,189 pixels. 
 
Porosity measures the degree of Core-Openings inside the contiguous foreground 

area. 𝑃𝑜𝑟𝑜𝑠𝑖𝑡𝑦 = 100 − (
𝐶𝑜𝑛𝑡𝑖𝑔𝑢𝑜𝑢𝑠

𝐼𝑛𝑡𝑒𝑟𝑛𝑎𝑙
∗ 100), Contiguous = Core+Edge+Perforation 

and Internal = Contiguous+Core-Openings. Forest porosity is 0% if the forest has no 
openings at all.  
 
If the Divide checkbox below the viewport is checked, the statistics for the MSPA class 
Core will be provided individually for small/medium/large Core areas.  
Please note that the purpose of these basic statistics is to provide a quick summary 
only. For example, the statistics do not account for the distinction of internal/external 
Core classes. The statistics will be reset in case of changing a MSPA parameter 
affecting the statistics. More details on the MSPA classes are available in Help → GTB 
Documentation → MSPA Guide.  
 
MSPA-plugins with documentation and installers are available for ArcGIS, R, and QGIS. 
They can be downloaded from the MSPA-website. 
MSPA is also available as a standalone executable for inclusion into custom scripts. 
More details on the use and settings of the standalone version can be found on the 
last page of the Help → GTB Documentation → MSPA Guide. 
 
Additional information is summarized in the MSPA Guide and Product Sheet. 

 

https://ies-ows.jrc.ec.europa.eu/gtb/GTB/psheets/GTB-Pattern-Morphology.pdf
https://ies-ows.jrc.ec.europa.eu/gtb/GTB/MSPA_Guide.pdf
https://ies-ows.jrc.ec.europa.eu/gtb/GTB/MSPA_Guide.pdf
https://forest.jrc.ec.europa.eu/en/activities/lpa/mspa/
https://ies-ows.jrc.ec.europa.eu/gtb/GTB/MSPA_Guide.pdf
https://ies-ows.jrc.ec.europa.eu/gtb/GTB/psheets/GTB-Pattern-Morphology.pdf
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4. The Viewport window (top right panel) 
 
This window displays the original, processed or the zoomed area of the image. The 
image is either displayed in its original size or automatically downsized to fit into the 
GTB viewport. Any processing is performed on the original non-zoomed image. The 
icon of the mouse pointer inside the viewport can be changed via the General Tools 
→ Switch Cursor option. 
 
 
 

5. The Pixel Locator/Value panel (below the viewport)  
 
This panel below the viewport shows the pixel coordinates, value, and type for the 
current location of the mouse pointer in the viewport. This feature works in full display 
as well as in Zoom Mode. It will also list related specific class names when investigating 
certain image types in the viewport, i.e., MSPA, FAD or MCD. 
 
 
 

6. The Divide Range panel (below the viewport) 
 
This panel below the Pixel Locator/Value panel allows dividing the data range of the 
following image types into the 3 groups: small/medium/large. The two thresholds 
defining these groups are defined via two drop-down menus. The user can either 
select predefined settings or enter custom thresholds to define threshold values for 
the 3 groups. A new custom value will only be assigned after the Enter key has been 
pressed. 

• MSPA: divide the MSPA core area [pixels], 

• Fragmentation: divide the Fragmentation range [%], 

• Contortion: divide the Contortion range, 

• Isochrone Map: divide the travel time range, 

• Distance: Divide the distance range [pixels] for foreground and background. 

• Influence Zones: define the width of buffer zones into the Foreground (to 
define Core-objects) and into the Background (buffer zones ranging outside of 
Foreground or Core objects), 

• Proximity: define CoreZones and maximum proximity values of interest. 
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7. Limitations, known issues and tweaks 
 
The following list summarizes known limitations and provides suggestions for 
potential issues arising when using GTB: 
 
1. Proxy: GTB includes an automatic proxy-detection, which can be disabled by 

placing an empty file noproxycheck.txt into the GuidosToolbox\data folder. 
2. GTB image dimensions: the module-specific maximum dimensions measured in 

pixels in x and y are listed under Help → ABOUT GTB. By default, GTB can load 
images up to 30,000 x 30,000 pixels. This limitation can be disabled by placing an 
empty file nolimits.txt into the GuidosToolbox\data folder. Warning: using this tweak 
is unsupported and may result in system hangs or program crashes! For processing 
of large images use GWB, which has no size limitations. 

3. MSPA image dimensions: up to 10,000 x 10,000 on MS-Windows. On Linux and 
macOS, the maximum size for MSPA processing is larger and recalculated 
dynamically accounting for the currently available amount of free RAM, click on 
Help → ABOUT GTB. Alternatively, one of the SPA modules may suffice, 
supporting image dimensions up to 30,000 x 30,000. MSPA TILING is another 
workaround or even better, use GWB, which has no size limitations.  

4. Restoration Planner: analysis schemes based on GGEO may be very slow.  
5. GTB window size: the size of the application window is driven by the currently 

loaded image dimensions and cannot be maximized to fit the entire screen.  
6. Save Image → kml: on certain 64-bit versions of MS-Windows, the option to save 

an image in kml-format may not work due to a conflict with other GIS-software 
installed in the system. A patch to address this issue is available in the folder 
C:\GuidosToolbox\guidos_progs\. Double-click the file fix_saveaskml.bat and provide the 
administrator password to apply the patch.  

7. GDAL: the GTB MS-Windows included version is 1.11.3. Newer versions with 
additional features can be obtained from the GDAL Binaries website.   

8. Data folder on network drive: the full path to the image filename must not contain 
any empty spaces, special or non-Latin characters (diacritics, ligatures).  

9. Concurrent use of external software: simultaneous opening/processing of the 
same raster file in GTB and another software (QGIS, ArcGIS) should be avoided. 

10. Concurrent use of GTB: running multiple instances of GTB from the same 
installation directory may cause overwriting temporary files within the program 
directory, resulting in program crashes or erroneous results. Multiple instances of 
GTB on the same machine can be run but must be executed from different 
installation directories. 

11. Batch processing under MS-Windows: a MS-Windows system-inherent problem 
will limit the number of files for batch processing (maximum 32,000 bytes of string 
can be read). Either shorten the length for the full path to the image files, use the 
Linux/macOS version of GTB, or even better use GWB. 

12. Undo/Redo: this step may not always work reliably. Since only one processing step 
is saved, the user is advised to save intermediate results to the hard drive. 

13. GTB for MS-Windows 32-bit has been discontinued. The latest, unsupported 
version 2.702 can be downloaded from the GTB homepage.  

https://forest.jrc.ec.europa.eu/en/activities/lpa/gwb/
https://forest.jrc.ec.europa.eu/en/activities/lpa/gwb/
https://gdal.org/download.html#binaries
https://en.wikipedia.org/wiki/Diacritic
https://en.wikipedia.org/wiki/Ligature_(writing)
https://forest.jrc.ec.europa.eu/en/activities/lpa/gwb/
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